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1 « Introduction to the Dionex AS-DV

1.1

Overview of the Dionex AS-DV

The Thermo Scientific Dionex " AS-DV Autosampler is a compact autosampler
that is capable of delivering between 0.1 mL and 5.0 mL of sample (in 0.1 mL
increments) to the sample loop or concentrator column in an ion chromatography
(IC) system. The Dionex AS-DV is compatible with the Thermo Scientific
Dionex ICS-5000, 1CS-2100, ICS-1600, ICS-1100, and ICS-900 systems, as well
as legacy IC systems.

The Dionex AS-DV holds 50 vials (either 0.5 mL or 5.0 mL, or a combination of
the two sizes). Vials can be sampled in any order and multiple samples can be
taken from each vial. The autosampler remembers the vial size and volume
delivered for each vial position, allowing multiple samples to be taken from a vial
non-sequentially.

The unique Thermo Scientific Dionex PolyVial " sample vial incorporates a cap
that acts as a simple piston to force sample out of the vial. This eliminates the
need for an external sampling pump. Sample can be delivered to a sample loop or
a concentrator column with backpressures up to 690 kPa (100 psi). Caps with a
20 um filter are available to remove solid materials from the sample before
injection.

The Dionex AS-DV can be configured either without a valve (the standard
configuration) or with an optional 6-port high-pressure valve or 10-port high
pressure valve.

The Dionex AS-DV is controlled with a PC configured with Thermo Scientific
Dionex Chromeleon® 7 Chromatography Data System (release 7.0 or later) or
Chromeleon 6.8 Chromatography Data System (release 6.80 SR6a or later). The
autosampler connects to the Chromeleon PC with a USB cable.

The Dionex AS-DVcan also be operated under relay control from a device
capable of executing timed events, such as a previous generation IC system
without USB connectivity.
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The Dionex AS-DVcan be ordered with the accessories needed for sampling from
either 0.5 mL vials or 5.0 mL vials:

e Order P/N 068908 to sample from 0.5 mL vials (Ship Kit P/N AAA-071115)
e Order P/N 068907 to sample from 5.0 mL vials (Ship Kit P/N 068887)

NOTE Vials must be ordered separately.

1.2 About This Manual
The electronic version (i.e., PDF file) of the Dionex AS-DVoperator’s manual
contains numerous links that you can click to take you to other locations within
the file. These links include:
= Table of contents entries
* Index entries
= Cross-references (underlined in blue) to sections, figures, tables, etc.
If you are not familiar with how to navigate PDF files, refer to the Help system for
Adobe® Acrobat® or Adobe Reader® for assistance.
Chapter 1, Introduces the Dionex AS-DV; explains the conventions
Introduction used in this manual, including safety-related information.
Chapter 2, Describes Dionex AS-DVoperating features and the
Description software required for autosampler control.
Chapter 3, Provides operating instructions for the Dionex AS-DV
Operation and and describes routine preventive maintenance procedures.
Maintenance
Chapter 4, Lists problems and presents step-by-step procedures for
Troubleshooting how to isolate and eliminate the cause of each problem.
Chapter 5, Provides step-by-step instructions for routine service and
Service parts replacement procedures that the user can perform.
Appendix A, Contains the Dionex AS-DVspecifications and facility
Specifications requirements.
Appendix B, Provides specifications and installation site requirements
Installation for the Dionex AS-DV.
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1 « Introduction to the Dionex AS-DV

Appendix C, Provides details about setting up the Dionex AS-DVfor
Relay Control relay control operation.

Appendix D, Lists part numbers of sample vials and other supplies for
Reordering convenience when reordering.

Information

1.

w

Safety and Regulatory Information

The Dionex AS-DV was manufactured by Thermo Fisher Scientific at the
following location: 527 Lakeside Drive, Sunnyvale, CA 94088-3603 U.S.A. The
Dionex AS-DV is designed for use with ion chromatography (IC) systems and
should not be used for any other purpose. Thermo Scientific does not recommend
the use of flammable solvents in the Dionex AS-DV vials. Operation of a Dionex
AS-DV in a manner not specified by Thermo Scientific may result in personal
injury.

If there is a question regarding appropriate usage, contact Technical Support for
Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S.
and Canada, call the nearest Thermo Fisher Scientific office.

1.3.1 Safety Messages and Notes

This manual contains warnings and precautionary statements that, when
properly followed, can prevent personal injury to the operator and/or
damage to the Dionex AS-DV. Safety messages appear in bold type and
are accompanied by icons, as shown here.

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

P>

DANGER

Indicates a potentially hazardous situation which, if not avoided, may
result in death or serious injury.

P>

WARNING

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or
practice that may seriously damage the instrument, but will not cause
injury.

P>

CAUTION

Indicates that the function or process of the instrument may be
IMPORTANT| . . . .
impaired. Operation does not constitute a hazard.

!
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Messages d’avertissement en frangais

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entrainera des blessures graves a mortelles.

P>

DANGER

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entrainer des blessures graves a mortelles.

>

AVERTISSEMENT

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entrainer des blessures mineures a modérées. Egalement
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entrainera pas de
blessures.

>

MISE EN GARDE

Warnhinweise in Deutsch

Bedeutet unmittelbare Gefahr. MifBachtung kann zum Tod oder
schwerwiegenden Verletzungen fiihren.

>

ACHTUNG

Bedeutet eine mdgliche Gefahrdung. MiBachtung kann zum Tod oder

schwerwiegenden Verletzungen fiihren.
WAR

4
(=)
4
(]

Bedeutet eine mogliche Gefahrdung. MiRachtung kann zu kleineren
oder mittelschweren Verletzungen fiihren. Wird auch verwendet, wenn
eine Situation zu schweren Schaden am Gerét fuhren kann, jedoch
keine Verletzungsgefahr besteht.

>

VORSICHT

Informational messages also appear throughout this manual. These are
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert
you to an unexpected result of an action, suggest how to
optimize instrument performance, etc.
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1 « Introduction to the Dionex AS-DV

1.3.2 Safety Symbols

The symbols below appear on the Dionex AS-DV or on Dionex AS-DV
labels.

— Alternating current

Secondary protective conductor terminal

Q_; Primary protective conductor terminal

| Power supply is on

Power supply is off

ﬁ Indicates a potential hazard. Refer to this operator’s
manual for an explanation of the hazard and how to
proceed.

1.4 Deionized Water Requirements for IC

For all procedures requiring deionized water, use ASTM Type | (18 megohm-cm)
filtered and deionized water that meets the specifications listed in Table 1-1.

Contaminant Specification
lons—Resistivity >18.0 (megohm-cm)
Organics—-TOC <10 ppb
Iron/Transition Metals* <1 ppb

Pyrogens <0.03 (Eu/mL)
Particulates > 0.2 um <1 (units/mL)
Colloids-Silica <10 ppb

Bacteria <1 (cfu/mL)

* Iron/transition metal content not specified for ASTM Type | Water

Table 1-1. ASTM Filtered, Type | Deionized Water Specifications
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14.1

Declaration of Conformity

The cETLus and CE marks on the Dionex AS-DV model/data label
indicate that the autosampler is in compliance with the following
standards.

MANUFACTURERS
DECLARATION OF CONFORMITY

Product Identification

Product: Automated Fluid Sampler
Brand: Dionex
Model: AS DV

Manufacturer Dionex Corporation

1228 Titan Way
Sunnyvale, California 94088
USA

Representative Larry McNary
Dionex Corporation
1228 Titan Way
Sunnyvale, CA, USA 94085

Function: Director, Engineering
Means of conformity
The product is in conformity to the listed directives and standards:

Low Voltage/Safety Directive: 73/23/EEC
EMC Directive: 89/336/EEC

Safety Standards: IEC/EN 61010-1:2001
UL 61010-1 2004/07/12 revised 2005/07/12
CAN/CSA-C22.2 No. 61010.1-2™ edition 2004/07/01

EMC Standards: EN 61326-1:2006
. - 2 ""*—e\ N
Signature of Representative: (=" oV Y \ Vo N
1
Name: Larry McNary
Place: Sunnyvale, CA, USA
Date: 23 Feb. 2009
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2 * Description

2.1 Operating Features

2.1.1 Front View
Figure 2-1 illustrates the main operating features of the Dionex AS-DV.

Carousel Cover Vial Carousel

Carousel
Release Button
(Not visible in

photo)

Sampling
Head Tower

. 4
- ol
R Front Cover

LED Display

Figure 2-1. Dionex AS-DV Front View
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LED Display

CONNECTED ALARM CAROUSEL

Figure 2-2. Status LEDs

Four LEDs on the Dionex AS-DV front panel (see Figure 2-2) indicate
the status of the following autosampler functions.

CONNECTED This LED is on when the Dionex AS-DV is connected to

Chromeleon.

ALARM This LED flashes when a problem has occurred. Check
the Chromeleon audit trail for the cause.

CAROUSEL This LED is on when the carousel is engaged.

POWER This LED is on when the Dionex AS-DV power is on.

Other status information and alarm messages are displayed in the audit
trail in Chromeleon. For a description of these messages, see Section 4.1.

Sampling Mechanism

The sampling mechanism consists of a sampling head tower, a vial
carousel, and a carousel cover (see Figure 2-1).

* The sampling head tower delivers sample from the sample vials to the
sample out line, which exits the front of the Dionex AS-DV (see
Section 2.1.2). For a description of how the sampling mechanism
operates, see Section 2.2.1.

= The carousel holds the PolyVials containing sample or rinse solution.
Vial numbers are molded into the top of the carousel to indicate the
sampling position. Vials can be placed in any order in the carousel.
The Chromeleon sequence controls the order in which sampling
occurs. For a description of how to create a sequence, see Section 3.6.

Sensors in the sampling mechanism detect the presence (and the size)
of the vial under the sampling head tower.

8 Doc. 065259-05 10/12




2 « Description

= The carousel cover protects light-sensitive samples and the interior of
the Dionex AS-DV. To access the sampling head tower and carousel,
lift up the cover.

To avoid trapping dust particles in the vial caps, always operate the
IMPORTANT Dionex AS-DV with the carousel cover closed.

Carousel Release Button

The Carousel Release button on the inside of the chassis performs two
functions:

e Engages and disengages the carousel from the motor.

* Resets vial memory (clears presence, vial size, and volume remaining
information). Before starting a run, always press Carousel Release t0
reset the vial information.

[IMPORTANT] Before starting a run, always press the Carousel Release button to
disengage the carousel and reset the vial information. After loading

the vials in the carousel, press the Carousel Release button again to
engage the carousel.

PolyVials

The vial carousel holds up to 50 0.5 mL or 5.0 mL disposable plastic
PolyVials or a combination of the two sizes. Vial adapters (P/N 071901,
package of 50) are required to load 0.5 mL vials into the carousel.
Adapters are included in the Dionex AS-DV Ship Kit for 0.5 mL vials
(P/N AAA-071115). PolyVials serve both rinse and sample functions.

NOTE Thermo Fisher Scientific does not recommend the
use of flammable solvents in the Dionex AS-DV
vials.

Vial Caps

Vial caps perform an important function in sample loading (see

Section 2.2.1). They also minimize evaporation, contamination, or spills
of sample while awaiting use. Caps with 20 um filters are available. The
filter traps particulates that might contaminate the analytical system.
PolyVials and caps can be used for loading sample to either a sample loop
or a concentrator column. An insertion tool (P/N 037987), included in the

Doc. 065259-05 10/12 9



Dionex AS-DV Operator’s Manual

Dionex AS-DV Ship Kit, simplifies insertion of the caps. Appendix D
contains part numbers for PolyVials, vial caps, and other accessories.

Vial Adapters

Before loading a 0.5 mL vial into the carousel, insert a vial adapter

(P/N 071901, package of 50) onto the vial (see Figure 2-3). After you
load the vial into the carousel, twist the adapter slightly to the right to lock
the adapter in place.

Adapter for 0.5 mL vial . .
Adapter installed on vial

Figure 2-3. Vial Adapter for 0.5 mL Vials

Vial Tray

Vial trays (either for 0.5 mL or 5.0 mL vials) are included in the
respective Dionex AS-DV Ship Kit (P/N AAA-071115, Ship Kit for

0.5 mL vials; P/N 068887, Ship Kit for 5.0 mL vials). Place vials into the
tray and then fill them until the liquid in the vials reaches the top of the
tray.

10 Doc. 065259-05 10/12



2 « Description

Fill vials to
this level

Figure 2-4. Vial Tray (0.5 mL Version Shown)

2.1.2 Front Interior Features

Figure 2-5 illustrates the front interior of the Dionex AS-DV. To access
the front interior, remove the front cover by gripping the indentations at
each side and pulling the cover straight off toward you.

L]
Sample
)]
= I
Optional
Valve

Figure 2-5. Front Interior View with Optional High-Pressure Valve
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Sample Out Line

The sample out line is routed from the sampling mechanism through an
aperture in the front interior. From there, it is connected either to the high-
pressure valve in the Dionex AS-DV (if installed) or to the injection valve
in the IC system.

High-Pressure Valve (Optional)

Either a 6-port or a 10-port high-pressure valve can be installed in the
Dionex AS-DV. The valve can be configured to operate as an injection
valve or an auxiliary valve in an application (for example, it can be used
as a bleed valve or to load a concentrator column).

For details about operation of the high-pressure valve, see Section 2.2.3.
For valve installation instructions, see Section B.3.2.

12
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2 « Description

2.1.3 Rear Panel
Figure 2-6 shows the features on the rear of the Dionex AS-DV.

I — . @
i i
& . J

Drain Port USB Relay and TTL Power Switch, Fuse Drawer,
Connector Connector and Power Receptacle
Figure 2-6. Dionex AS-DV Rear Panel
Drain

Liquid from any spills exits the Dionex AS-DV enclosure through the
DRAIN port. Connect a drain hose (P/N 055075) to the port and place the
free end of the hose into either a waste container or an appropriate drain.
The drain hose is included in the Dionex AS-DV Ship Kit.

Neutralize acidic and caustic wastes before disposal. Dispose of all
wastes in accordance with local regulations.

CAUTION
Neutralisez les déchets acides ou caustiques avant de les jeter. Jetez
les déchets aux réglements locaux.

MISE EN GARDE
Neutralisieren Sie saurehaltige und &tzende Abféalle vor ihrer
Entsorgung. Entsorgen Sie alle Abfalle entsprechend den lokalen
Bestimmungen.

VORSICHT
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CAUTION

MISE EN GARDE

VORSICHT

USB Connector

The USB connector connects the Dionex AS-DV to the PC on which
Chromeleon is installed. Connect a USB cable between the USB
connector on the Dionex AS-DV and a USB port on the PC. Alternatively,
the Dionex AS-DV can be connected to a hub or an IC system with a USB
port. For USB connection instructions, see Section B.6.

Relay and TTL Connector

The relay output can be used to control functions in other TTL- or relay-
controllable devices. The TTL input can be used to start the Dionex AS-
DV load cycle. For connection and operation instructions, see

Appendix C.

Power Switch, Fuse Drawer, and Power Receptacle

* The power switch provides on/off control of power to the Dionex AS-
DV.

e The fuse drawer contains two fast-blow IEC 127 fuses rated 3.15 A
(P/N 954745). For instructions on how to change the fuses, see
Section 5.7.

= The power supply cord plugs into the IEC 320 three-prong receptacle.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the Dionex AS-DV and is easily
accessible.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez & ce que la prise de base soit
situéelinstallée pres du module et facilement accessible.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, dal3 sich die Steckdose nahe am Geréat befindet und
leicht zugénglich ist.

14
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2 « Description

2.2 Dionex AS-DV Operating Principles

221

Sampling Operating Principles

The sampling head tower (see Figure 2-1) consists of a motor-driven
needle, with a sampling tip on the end, that moves down to engage the top
of the vial cap.

As the needle moves downward, the cap is gradually pushed into the vial
(see Figure 2-7), forcing the liquid through the filter (if present) and into
the sample out line. The moving cap acts as a piston to force the liquid
from the vial. This allows samples to be loaded without the use of an
external sampling pump. The concave bottom of the vial cap traps air, so
that it can be expelled with any excess sample above the fill line. In
addition, the shape exactly matches the convex bottom of the sample vial;
when the cap is pushed completely into the vial, virtually all of the sample
is expelled.

The socket for the sampling tip is identical on both sizes of caps to allow
mating with the tip of the sampler head. The sampling head speed
(delivery speed) is set in Chromeleon (see Section 3.5).

Fill Line

Sample Out Line
Needle

Sampling Tip

Cap

20 um Filter (Optional)

Trapped Air and Excess Sample
(Expelled before sample delivery
if Bleed is enabled)

| — Sample

Convex vial bottom mates
| — with concave cap to ensure
complete delivery of sample

Figure 2-7. PolyVial, Cap, and Sampling Tip Features
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222

2.2.3

CAUTION

During a bleed, the cap is pushed into the vial, starting from its topmost
position and stopping when it reaches the position at which the Dionex
AS-DV begins measuring the injection volume.

Rinsing Operating Principles

To deliver a rinse, the Dionex AS-DV performs the basic operation used
for delivering a sample. A vial containing the rinse liquid is moved to the
sampling head tower and the rinse liquid is delivered from the vial
through the sample out line. You can intermix sample vials and rinse vials
in any order in the carousel. The position of the rinse vial in the carousel
and the volume of rinse liquid to deliver is defined in Chromeleon.

You can also designate a range of vial positions to be reserved for rinse
vial use only. The rinse vial range is defined in the Chromeleon 7
Instrument Configuration Manager or the Chromeleon 6.8 Server
Configuration program (see Section B.8.2). When performing a rinse, the
Dionex AS-DV takes the rinse liquid from the first vial in the range. If the
first vial is empty, the next vial in the range is used, and so on.

To define rinse cycles in Chromeleon, see Section 3.8.3.

Optional High-Pressure Valve Operating Principles

A high-pressure valve can be installed in the Dionex AS-DV. Two models
are available: 6-port and 10-port. Both models are electrically-activated,
2-position valves. See the table below for valve kit part numbers.

Valve Kit Description Part Number
6-Port High-Pressure Valve Kit 068920
10-Port High-Pressure Valve Kit 068921

The Dionex AS-DV power must be turned off before you install or
rebuild a valve. If the power is on when you connect or disconnect the
valve cable, the Dionex AS-DV may be damaged.

16
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Figure 2-8 and Figure 2-9 show the flow schematics for the 6-port and 10-

port valves.
A Position B Position
5 4 5 4
6 3 6 3
1 2 1 2

Figure 2-8. Optional 6-Port High-Pressure Valve Flow Schematics

A Position B Position

Figure 2-9. Optional 10-Port High-Pressure Valve Flow Schematics

Operation as an Application Valve

The optional valve can be configured for various application functions,
including sample injection, concentrator column loading, or matrix
elimination.

Plumbing configurations for the valves depend on the components to be
connected and the application to be run. Refer to the appropriate Thermo
Scientific Dionex Application Note for more information.

Operation as a Bleed Valve

When the optional valve is configured as a bleed valve (see Figure 2-10
and Figure 2-11), the valve directs excess sample and any air trapped in
the sample vial to waste. Excess sample is any sample above the fill line
on the vial (see Figure 2-7). After the initial bleed, the valve position is
switched and the sample is sent directly to the injection valve in the IC
system.
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IC System

AS-DV

Optional Valve
(A Position)

»

AS-DV Sample Out Line

PolyVial

v

To Waste

Injection Valve To Column
(Load Position)
-
[ ]
Sample Loop
or Concentrator
Column

—— From Pump

A 4

To Waste

Figure 2-10. Optional 6-Port High-Pressure Valve: Configured as a Bleed Valve

IC System

AS-DV

Optional Valve
(A Position)

Injection Valve
(Load Position)

To Column

AS-DV Sample Out Line

PolyVial

v

To Waste

Sample Loop
or Concentrator
Column

— From Pump

A

y

To Waste

Figure 2-11. Optional 10-Port High-Pressure Valve: Configured as a Bleed Valve
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2.3 Chromeleon Software

The Dionex AS-DV is controlled with a PC configured with Chromeleon 7
Chromatography Data System or Chromeleon 6.8 Chromatography Data System.

2.3.1 Software Control Modes

Two modes of software control are available: direct control and
automated control.

= With direct control, you select operating parameters and commands
from the Dionex AS-DV ePanel on the Chromeleon 7 ePanel Set (see
Figure 2-13) or from the Control panel on the Chromeleon 6.8 panel
tabset (see Figure 2-13). Direct control commands are executed as
soon as they are entered.

IC5-900.© AS-DV | Audit Queue

Q ot (i)

SleEs - Retention !
Operating Status Ready Date Time Time Device Meszage
Dieliver Status Completed @ 5122010 10:33:38 AM Uzer AMarguardt...
‘ial Size m_ o BAz2010 10:38:31 AM I nitializing driver D..
Yolums Remaining | 5000 © 5120200 10:38:31 A Driver Diokrex 1C5-..
© 5122010 103828 AM Ihitializing driver D..
Settings g 525200 10:38:27 AM Initializing driver D..
) - = BAz22010 10:38:27 Ak Initializing driver d..
Deliver Speed 1.0 mifmin > © SH25010 109827 bM IC5-300 - Chromel.
Deliver Volume 5000 2 @ 5712/20010 10:38:18 AM | nitializing driver ...
“ial Pasition 1 = © 512200 10:38:18 Ak Driver Dionex AS-.
@ =1z:200 103812 Ak Initializing driver D...
Commands @ =12200 10:38:11 &k Initializing driver d...

@ 5122200 10:38:171 AW AS-DY - Chromele...
Em ==

Walve

[ A Pogition ] [ B Position ]

l Wellness Panel l

Figure 2-12. Chromeleon 7 ePanel Set: Dionex AS-DV ePanel
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B8 Panel Tabset1 E'@

AS-DY Il
|C5-1600 System with Column Heater- ASVDV] Sequence Control] Status A5-DY |

AS-DY
W C 1
pnnee =0:00:33 AM Position = 3 =
Stat - B0:08:35 AM Sampler.DeliverSample Yalume = 5000,
Operating Status Ready Position =3
. éﬁflﬁiﬁlﬁﬁ' tod B5y0:08:40 AM Position= 4
D.ellvaerIatus ——a E9:05:41 AM Sampler DeliverSample Volume = 5000,
wial Size No_Vial Position = 4
Yolume Remaining ‘ﬁ;ﬂ E=R9:08:57 A Resetvials StartvialPosition=0,
EndvialPosition =0
Setting =9:17:25 AM Sampler VialPosition = 4
Deliver Speed 1.0 mlfmin E|i
5

Deliver Yolume 5000 o |
Wial Position 4 E|:

i
| Move to Vial | Deliver Sample
Stop Raise Heedle
A
Position A Position B |

Wellness Panel

rReset Vial Memory-

Reset All
Reset Vial Range | |0 E L] E

Start Pos. End Pos.

Figure 2-13. Chromeleon 6.8 Panel Tabset: Dionex AS-DV Control Panel

e With automated control, you create a predefined list of commands
and parameters (called an instrument method in Chromeleon 7 or a
program in Chromeleon 6.8) for controlling the Dionex AS-DV.
Instrument methods and programs can be created automatically (with
the help of a software wizard). For information about creating an
instrument method or a program, see Section 3.5.

2.3.2 System Wellness

System Wellness monitors the overall “health” of a chromatographic
system. It provides built-in diagnostic and calibration features that help
prevent unscheduled system shutdowns and assure reliable operation of
system devices. Use the Dionex AS-DV Wellness Panel (see Figure 2-14)

20
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to monitor the usage of replaceable parts. After replacing a part, click
Reset to reset the Current counter to 0.

FEX
Current Tatal
Carouzel Jam Counter 0 0
MNeedle Jam Counter ] 0
Speed Adjustment Counter [0 0
Yial Process Counter ] 0
Walve Actuation Counter 0 0

Figure 2-14. Dionex AS-DV Wellness Panel

e The Carousel Jam Counter increments each time the carousel jams.
e The Needle Error Counter increments each time the needle jams.

e The Speed Adjustment Counter increments each time the speed is
adjusted due to excessive liquid backpressure or a clog.

e The Vial Process Counter increments each time the carousel moves
a vial into place for processing.

* The Valve Actuation Counter increments each time the position of
the high-pressure valve (if installed) is switched.
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3 * Operation and Maintenance

This chapter describes routine operating and maintenance procedures for the
Dionex AS-DV.

3.1 Preparing the Sample Vials

Thermo Fisher Scientific recommends thoroughly rinsing all PolyVials and caps
with deionized water before filling to remove any traces of dust. Thermo Fisher
Scientific DOES NOT recommend reusing vials or caps and does not guarantee
their cleanness or proper operation if reused.

When performing trace-level analyses, use the procedure in Section 3.1.1 to clean
the vials. To clean the caps, use either the procedure in Section 3.1.2 (for caps
without filters) or Section 3.1.3 (for caps with filters).

IMPORTANT To prevent the introduction of contaminants onto the vials and filter
caps, extreme care must be used in cleaning. Use only ASTM Type |

(18 megohm-cm) filtered and deionized water that meets the
specifications listed in Table1-1 for the following cleaning
procedures.

NOTE Before cleaning, inspect each vial and cap for
damage (nicks, scratches, etc.).

3.1.1 Cleaning the Vials

1.
2.

Rinse the vials 10 times with a jet of deionized water.

Place the rinsed vials in a vial tray (for 0.5 mL vials, P/N 068948; for
5.0 mL vials, P/N 068947) and fill them to the top with deionized
water. Do not touch the tops or interiors of the vials with your fingers.

Allow the vials to soak for a minimum of 24 hours (48 hours, if
possible).

When you are ready to use a vial, empty it, and then rinse it 10 times
with a jet of deionized water. Shake out any excess water and then
rinse the vial twice with aliquots of sample.

Doc. 065259-05 10/12
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3.1.2 Cleaning the Caps
Use the following procedure to clean caps without filters.

IMPORTANT For trac_e-level analyses_, use caps without filters to avoid introducing
contaminants from the filter.

1. Place caps into a clean 4-liter polyethylene container. Fill the
container three-quarters full with deionized water and cap.

2. For trace-level analyses, allow the caps to soak for a minimum of
24 hours in deionized water. This allows time for contaminants to
leach out.

3. Vigorously agitate the container for 30 seconds. Drain the water.
Repeat four times.

4. Refill the container to the top with deionized water and cap.

5. When you are ready to use a cap, use clean forceps to remove one
from the container. Shake off any excess water and install the cap in
the vial.

3.1.3 Cleaning the Filter Caps
Use the following procedure to clean caps with filters.

1. Place caps into a clean 4-liter polyethylene container. Fill the
container three-quarters full with deionized water and cap.

2. Vigorously agitate the container for 30 seconds. Drain the water.
3. Empty the caps onto a clean surface.

4. Using a clean syringe, force 50 mL of deionized water through the
filter frit from the top of the cap. Be sure not to dislodge the filter frit.

5. Place the rinsed caps into a clean 4-liter polyethylene container. Fill
the container three-quarters full with deionized water and cap.

6. Vigorously agitate the container for 30 seconds. Drain off the water.
Repeat four times.

7. Refill the container to the top with deionized water and cap.

8. When you are ready to use a cap, use forceps to remove a cap from
the container. Shake off any excess water and install the cap in the
vial.
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3.1.4 Filling the Vials and Installing the Caps

A cap must be installed in each vial in order for the autosampler to
IMPORTANT ; . .
operate correctly. A vial without a cap will be sensed as an empty

position.

NOTE To prevent contamination when doing trace-level
analyses, use forceps to handle the vials and caps.
Also, avoid touching any surface that will be wetted
with sample.

1. After rinsing, place the empty vials into a vial tray (for 0.5 mL vials,
P/N 068948; for 5.0 mL vials, P/N 068947).

2. Fill the vials with either sample or rinse solution until the liquid in the
vials reaches the top of the tray (see Figure 3-1). (Using a pipette
simplifies filling the 0.5 mL vials.) After filling, inspect the vials to
make sure no air bubbles are trapped at the bottom.

Fill vials

to this o q :-.
level ‘ ’ ’E
‘ h o ’
L%

Figure 3-1. Vial Tray

NOTE Do not underfill the vials. This may result in
insufficient sample being loaded for the first
injection.
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3. Install the cap in the vial:

* Fora 0.5 mL vial, orient the cap with the ridged end up (see
Figure 3-2) and place the cap in the vial.

e Forab5.0 mL vial, orient the cap with the small end up (see
Figure 3-2) and place the cap in the vial.

Ridges
on cap

E & 3
m——

0.5 mL Vial and Cap 5.0 mL Vial and Cap

Figure 3-2. Caps Partially Inserted in Vials

4. Use the flat end of the insertion tool (P/N 037987) (see Figure 3-3) to
press the cap into the vial to the proper depth (the top of the cap is
flush with the lip of the vial). The tool is provided in both Dionex AS-
DV Ship Kits (for 0.5 mL vials, P/N AAA-071115; for 5.0 mL vials,
P/N 068887).

Cap Insertion Tool

Figure 3-3. Caps Installed (0.5 mL Vials Shown)

NOTE Do not use the concave end of the cap insertion tool
for installing caps on Dionex AS-DV vials. It is for
use with another autosampler.
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5. Before loading the vial in the carousel, shake off any liquid that has
been forced into the cap socket.

NOTE Do not use laboratory wipes to blot liquid from the
cap sockets; wipes leave fibers which can
accumulate in the liquid flow path and cause
increased backpressure.

3.2 Turning on the Power

To turn on the autosampler power, press the power switch on the Dionex AS-DV
rear panel (see Figure 2-6).

At power-up, the sampling needle is homed (the needle is raised) and the carousel
is homed (vial position 1 is moved under the sampling head tower).

3.3 Loading the Vial Carousel

Raise the Dionex AS-DV top cover and press the
Carousel Release button on the inside of the
chassis. Pressing the Carousel Release button is
required for two purposes:

* To disengage the carousel from the motor.

* To reset vial memory (clear presence, vial size, \

and volume remaining information). Before
starting a run, always press Carousel Release to reset the vial information.

[IMPORTANT] Before starting a run, always press the Carousel Release button to
disengage the carousel and reset the vial information. After loading

the vials in the carousel, press the Carousel Release button again to
engage the carousel.

1. If you are using 0.5 mL vials, insert a vial adapter onto the vial.

2. Load the vials into the carousel. You can place the vials in any order. The
Chromeleon sequence (see Section 3.6) determines the order in which vials
are sampled. If you are using a reserved range of positions for rinse vials (see
Section B-8), place the rinse vials in the designated positions.
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3. Ifyou are using 0.5 mL vials, twist the
adapter slightly to the right to lock the
adapter in place in the carousel.

4. Pressthe Carousel Release button again
to engage the carousel with the motor
and home the carousel.

0.5 mL vial installed
in carousel

3.4 Connecting to Chromeleon

3.4.1 Connecting to Chromeleon 7
Turn on the PC.

Check the Chromeleon 7 Instrument Controller Service icon on the
Windows taskbar and start the service, if it is not already running.

1.
2.

If the icon is gray J& , the Instrument Controller Service is
running (idle).

If the icon is crossed out in red & the Instrument Controller
Service is not running. Right-click the icon and click Start
Chromeleon Instrument Controller. The icon changes to gold

Jéfé to indicate that the Instrument Controller Service is starting.

If the Chromeleon Tray icon is not on the Windows taskbar, click
Start > All Programs > Chromeleon 7 > Services Manager to
open the Services Manager and click Start Instrument
Controller.

To start the Chromeleon 7 client, click Start > All Programs >
Chromeleon 7 > Chromeleon 7.

To display the Dionex AS-DV ePanel, click the Instruments
category bar on the Console. Click your instrument in the Navigation

26
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Pane. Chromeleon 7 connects to the instrument and displays the
ePanel Set. Click the AS-DV tab (see Figure 3-4).

IC5-900.© AS-DV | Audit Qusue

Qoo (i)

Statuz

Operating Status Ready Date | Time He_lt_?rrggon | Device | Meszage

Deliver Status Completed || © 5112200 103338 AM Uzer AMarguardt...
\fial Size m || © 5Az20m0 10383 AM Initializing driver D..
Yolume Remaining  [5000 || © 5120200 10:38:31 A Driver Diokrex 1C5-..
|| o BAz2/2010 10:38: 28 AM Initializing driver D...
Settings || g 5272010 10:38: 27 &M I nitializing driver D...
) - = BA22010 10:38: 27 Ak I nitializing driver d..
Deliver Speed 10 mi/min T @ sAziemn 08 2 AN IC5-300 - Chromel.
Deliver Volume 5000 S| |@ snzemo 1omiEAM | nitializing driver D...
“ial Pasition 1 = : @ 512200 10:38:18 A Driver Diohex AS-.
@ 51220100 103812 AM Initializing driver ..

Commands || @ =122200 10:38:11 Ak I nitializing driver d..
: © 5Az20m0 103811 AM AS-DY - Chromele..

= =

Walve

’ A Position ] ’ B Position ]

l Wellness Panel l

Figure 3-4. Example Chromeleon 7 ePanel Set: Dionex AS-DV ePanel
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3.4.2 Connecting to Chromeleon 6.8
1. Turnonthe PC.

2. Check the Chromeleon 6.8 Server Monitor icon on the Windows
taskbar and start the server, if it is not already running:

e Iftheiconis gray %, the server is already running (idle).

e Iftheicon is crossed out in red 9%, the server is stopped. To start
the server, right-click the icon and select Start Server. The icon
changes to gold % to indicate that the Chromeleon 6.8 Server is
starting.

= If the Server Monitor icon is not on the Windows taskbar, click
Start and select All Programs > Chromeleon > Server
Monitor. The Server Monitor opens. Click Start to start the
server.

3. To start the Chromeleon client, click Start and select All Programs >
Chromeleon > Chromeleon.

4. To display the panel tabset,
select View > Default Panel
Tabset or click the Default
Panel Tabset toolbar button.

"% Chromeleon
File Wiew ‘Workspace Tools Help

Defaulk Panel Tabset
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5. Todisplay the Dionex AS-DV Control panel, click the AS-DV tab
(see Figure 3-5).

§8 Panel Tabset1

AS-DV i
1C5-1600 System with Column Heater- 45D ] Sequence Control } Status  AS-DV

AS-DV

W Connect
— =9.08:33 AM Position = 3 A

Stat 59:08:35 AWM Sampler.DeliverSample Yolure = 5000,
Operating Status | Pasition= 3
9:08:40 AW Position = 4
Delivar Status =
i =R9:02:41 AM Sampler.DeliverSample “olume = 5000,
lal zize

Position =4
Valume Remaining ou | R9:05:57 AM Resetvials StartvialPosition=10,
EndVialPosition=0
ing =901 7:25 AWM SamplerVialPosition = 4

Deliver Speed T0mlimin =
Deliver Volume 5000 =
Vial Position 4 E|:

i
Move to Vial Deliver Sample
Stop Raise Heedle
A
Position A Position B ]

Wellness Panel

rReset Vial Memory-

Reset All
Reset Wial Range| [0 =] [0 —

Start Pos. End Pos.

Figure 3-5. Example Chromeleon 6.8 Panel Tabset: Dionex AS-DV Control
Panel
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3.5

Creating a Chromeleon Instrument Method or
Program

NOTE Before creating an instrument method in Chromeleon 7

or a program in Chromeleon 6.8, be sure you have
completed the Chromeleon configuration steps in
Section B.8.

A Chromeleon 7 instrument method or Chromeleon 6.8 program is a list of
control commands to be executed at specified times, allowing automated
operation of the Dionex AS-DV. This section provides an overview of how to
create an instrument method or a program with a wizard. For detailed instructions,
refer to the Chromeleon Help.

3.5.1 Creating an Instrument or a Program with the Wizard

1.

Verify that the Chromeleon 7 Instrument Controller Service or
Chromeleon 6.8 Server is running (see Section 3.4).

Start the Chromeleon 7 Instrument Method Wizard or Chromeleon
6.8 Program Wizard:

e For Chromeleon 7: On the Console, on the menu bar, click the
arrow next to Create, and then click Instrument Method. Select
the instrument in which the Dionex AS-DV is configured and
click Next >.

e For Chromeleon 6.8: Select File > New. Select Program File and
click OK (or double-click Program File). Select the timebase in
which the Dionex AS-DV is configured and click Next >.

If the selected instrument or timebase includes other devices (for
example, a pump and detector), wizard pages for these devices are
displayed before the Dionex AS-DV page.

On each wizard page, select the required parameters and click Next >.
For details about a page, click the Help button.

On the Sample Preparation Options page for the Dionex AS-DV,
select the preferred options.

a. Under Loading Mode, select either Loop (to load a sample loop)
or Concentrator (to load a concentrator column).
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b. If required for your application, modify the General
Parameters. For details about the General Parameters, see
Section 3.5.2.
c. Select the Edit Mode. Refer to the following table to determine
the mode to select.
Use Basic mode if you want to ... Use Advanced mode if you want to ...
Deliver sample from the vial Deliver sample from a specified vial and
specified in the sequence. override the sequence.

Deliver one of the following sample  Deliver a different volume than is
volumes: volume specified in available in Basic mode. The volume can
sequence, full vial, one-halfofa5mL  be specified in 100 uL increments.

vial, one-third of a 5 mL vial.

Deliver rinse from the rinse vial range  Deliver rinse from any vial.
specified in the Chromeleon 7

Instrument Configuration Manager or

Chromeleon 6.8 Server Configuration

program.
Perform a bleed with the injection Use the optional Dionex AS-DV valve
valve or the auxiliary valve. for a function other than injection or

bleed.

NOTE The injection valve is either the optional Dionex
AS-DV high-pressure valve configured as an
injection valve, or the injection valve in the
chromatography system module. The auxiliary
valve is the optional Dionex AS-DV valve con-
figured as an auxiliary valve.

For Basic Edit Mode: Select the Volume of sample to deliver
from the vial, select a Bleed option, and enable or disable a
Rinse. For details about Basic Edit Mode, see Section 3.5.3.

For Advanced Edit Mode: Add, delete, or modify commands
and parameters in the Command/Parameters table. For details
about Advanced Edit Mode, see Section 3.5.4.

(Optional) If you selected From Sequence for the sample
delivery volume, you can use the Total Volume Delivered
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3.5.2

Estimator to estimate the volume of sample the Dionex AS-DV
will deliver to the loop or concentrator column. The estimate is
provided for informational purposes only. In the Loop Volume
box, enter the volume of the loop installed on the injection valve.

5. After specifying the Dionex AS-DV options, click Next > and
complete the remaining wizard pages.

Dionex AS-DV General Parameters

The following general parameters are included on the Sampler
Preparation Options page.

Delivery Speed: Determines the speed at which the sample is delivered to
the sample loop or concentrator column. The following table shows the
recommended delivery speeds:

Vial Size Type Speed (mL/min)

Small (0.5 mL) Loop 1.6
Concentrator 0.4

Large (5.0 mL) Loop 4.0
Concentrator 1.0

Delay Volume: Specifies the volume from the tip of the sampling needle
to the injection valve. The range is 0 to 500 pL. The default value of
125 pL is appropriate for the 1.4 m (56 in) length of sample out line
provided with the Dionex AS-DV. You can set the Delay Volume in the
Chromeleon 7 Instrument Configuration Manager or the Chromeleon 6.8
Server Configuration program (see Section B.8.2).

Cycle Time: To set a uniform time between injections, select this check
box and enter the time in minutes. The time between injections is never
shorter than the specified cycle time. However, if the previous instrument
method or program is still running when the cycle is over, cycle time will
be ignored. Clear the Cycle Time check box to let the commands entered
in the instrument method or program determine the time between
injections.

Flush Factor: Chromeleon uses this parameter in the formula that
determines the volume of sample delivered from the vial. The formula is
shown in the Total Volume Delivered Estimator.

32
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If Loop Mode is selected, enter a factor (1 to 10) to determine how much
excess sample will be flushed through the sample loop. If Concentrator
Mode is selected, the Flush Factor is always 1.

For details about controlling injection volumes, see Section 3.8.7.

3.5.3 Basic Edit Mode

When you select Basic Edit Mode on the Sample Preparation Options
page of the Instrument Method Wizard or Program Wizard, a default list
of commands is displayed in the Command/Parameters table. The
Dionex AS-DV executes the commands in the order in which they appear
in the table.

Default Basic Edit Mode Commands

= LoadPosition: Switches the injection valve to the load position.

= DeliverSample: Delivers the injection volume to the loop. By
default, the Dionex AS-DV uses the injection volume and vial
position specified in the sequence.

e EndSamplePrep: Identifies the end of a group of sample preparation
commands. This command is used when sample overlap operation is
enabled in the Chromeleon 7 Instrument Configuration Manager or
Chromeleon 6.8 Server Configuration program (see Section B.8.2).

* Inject (Chromeleon 6.8 only): Injects the sample.

You can modify the list of default commands by selecting among several
options (Volume, Bleed, Rinse). When you select an option, Chromeleon
adds the appropriate commands and parameters to the Command/
Parameters table.

Basic Edit Mode Options

* Volume: Specifies the volume of sample to deliver from the vial to
the injection valve or concentrator. For details about controlling the
delivery volume, see Section 3.8.7.

e Bleed: Delivers excess sample (and any trapped air) from the vial to
waste before delivering the injection volume to the loop or
concentrator column. To enable the bleed, select the valve position
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that will direct the bleed to waste. To disable the bleed, select None.
For details about performing a bleed, see Section 3.8.2.

Rinse: Delivers rinse fluid through the sample out line. To enable the
rinse, select the check box and then specify the volume. The volume
is taken from the vials in the rinse vial range, specified in the
Chromeleon 7 Instrument Method Manager or Chromeleon 6.8
Server Configuration program. For details about performing a rinse,
see Section 3.8.3.

3.54 Advanced Edit Mode

When you select Advanced Edit Mode on the Sample Preparation
Options page of the Instrument Method Wizard or Program Wizard, you
can create a customized list of commands for preparing samples.
Selecting this option enables editing of the Command/Parameters table.
The order in which commands appear in the Command/Parameters
table determines the order in which they will be executed. You can add,
delete, and modify commands and select additional commands and
parameters not available in Basic Edit Mode.

Advanced Edit Mode Commands

LoadPosition: Sets the injection valve to the load position.
InjectPosition: Sets the injection valve to the inject position.

DeliverRinse: Delivers rinse fluid through the sample out line. Enter
the Volume of rinse to deliver and the Vial from which to take the
rinse volume. For details about specifying a rinse, see Section 3.8.3.

DeliverSample: Delivers sample through the sample out line. Enter
the Volume of sample to deliver and the Vial from which to take the
sample. If you want to take the sample from the vial position entered
in the sequence, select From Sequence. If you want to take the
sample from a particular vial and override the vial position entered in
the sequence, select a specific vial number or a relative vial position
(CurrentVial, CurrentVial +1, etc.). For details about controlling
the delivery volume, see Section 3.8.7.
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The following two commands are available only if the optional valve is
installed and configured as an auxiliary valve (see Section 2.2.3).

AuxValve.A: Sets the valve to the A position.

AuxValve.B: Sets the valve to the B position.

Adding, Modifying, and Deleting Commands

To add a command to the end of the Command/Parameters table,
select the command in the Command list, enter the command
parameters (if any), and click Insert (Chromeleon 7) or Append
(Chromeleon 6.8).

To add a command above another command in the Command/
Parameters table, first select the command listed immediately below
the intended location of the new command. Then, in the Command
list, select the command to be added, enter the command parameters
(if any), and click Insert. The original command remains selected, to
allow you to easily add commands in chronological order.

To change an existing command, select the command in the table,
change the command parameters or select a new command, and click
Change (Chromeleon 7) or Modify (Chromeleon 6.8).

To delete a command from the Command/Parameters table, select
the command and click Delete.

Notes:

The EndSamplePrep command cannot be deleted.

In Chromeleon 6.8, the Inject command is always the last command
in the list; it cannot be moved or deleted.
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3.6

Creating a Chromeleon Sequence

A Chromeleon sequence determines the order in which samples will be processed.
This section provides an overview of how to create a sequence with the Sequence
Wizard. For detailed instructions, refer to the Chromeleon Help.

Creating a Sequence with the Sequence Wizard
1. Start the Sequence Wizard:

For Chromeleon 7: On the Console, on the menu bar, click Create. Select
the instrument in which the Dionex AS-DV is configured and click
Next >.

For Chromeleon 6.8: Select File > New. Select Sequence (using Wizard)
and click OK.

2. Complete each page of the wizard. For details about a page, click the Help
button on the page.

On the Unknown Injections or Unknown Samples page, define one or
more injections.

On the Standard Samples page (in Chromeleon 6.8 only), define one or
more standard injections or click Next > to skip this page.

On the Methods & Reporting page, specify an instrument method or a
program that includes commands for Dionex AS-DV operation (see
Section 3.5).

Notes:

* When defining injections, enter the volume of the loop installed on
the injection valve in the Inj. Vol. box. This ensures that calculations
for the total volume delivered are correct. For details about specifying
the delivery volume, see Section 3.8.7.

= After you complete the Sequence Wizard, you can edit the sequence.
For example, you can add or delete unknowns and standards, change
vial positions, or specify a different instrument method or program.

36
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3. On the last page of the wizard, click Finish (Chromeleon 7) or Done
(Chromeleon 6.8). The sequence opens on the Chromeleon 7 Console (see
Figure 3-6) or in the Chromeleon 6.8 Browser (see Figure 3-7).

'-éﬁ Chromelean Conso

la o omow
© ¢ fcreste +| Fle Edt  View Toos Help (7]
» AS-DV
New [ stat [ Fasov -] (idie)
4]
dqi = Print ~| | “F Filtering On = Grouping On |E, Up - =
= # ECD_1 b Mame | Type Paosition | Walume [u] | Ingtrument Method |
.E 1 [Mone E Irjection 1 Unknown 1 25 AS-DV Test
g - 2 |Mone E Injection 2 Unknown 2 28 AS-DV Test
% 3 |Mone E Irjection 3 Lnknown 3 il AS-DY Test
= —
‘““-i
'__*Iil 4] M | ) [»]
S e S P S o S PSS

Figure 3-6. Example Sequence on the Chromeleon 7 Console

HE AMARQUARDTZ_local\AS-DVYAS-DV Example - Browser

AMBR2_h A

- S amanoU
<1 AMAF
=

"
+-{_7] Autar

Mame

[ as18_Trace ot
A ASDV pgm

AZ15 Five Anion Stancard for Trace Analysi

+ I Aok
4 ot

<

Mo, [ Mame Type Poz | Inj. %ol. |Program Method Statuz  |Inj. D
1 m Standard 1 Standard 3 250 AS-DV AS15_Trace  Single
2 @ Sample 1 Unknown 1 250 AS.DY L5158 _Trace Single
3 E Sample 2 Unknowen 2 250 AS.DY L5158_Trace Single

Lis desnn o PP n .

Figure 3-7. Example Sequence in the Chromeleon 6.8 Browser
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3.7 Starting a Run

IMPORTANT Before starting a run, always press the Carousel Release button to
disengage the carousel and reset vial memory. After loading the vials
in the carousel, press the Carousel Release button again to engage

the carousel.

During a run, do not press the Carousel Release button. Doing so
clears all current vial information from Dionex AS-DV memory. (During
arun, the Dionex AS-DV stores the vial size installed in each carousel
position and the remaining volume in each vial.)

After creating the sequence, you can start a run.
e For Chromeleon 7:

On the Console, click Start on the Sequence Control Bar above the injection
list (see Figure 3-6).
e For Chromeleon 6.8:

On the panel tabset, click the Sequence Control tab. Click Load Sequence,
open the sequence you created, and then click Start Batch.

3.8 Operating Details

3.8.1 Interrupting the Autosampler

= To interrupt the autosampler when a sequence is running in
Chromeleon 7:

On the Console, click Stop on the Sequence Control Bar above the
injection list. Specify when to stop (immediately, after the current
sample, or after the current sequence).

= To interrupt the autosampler when a sequence is running in
Chromeleon 6.8:

Select Batch > Stop on the Chromeleon menu bar. Select when to
stop (immediately, after the current sample, or after the current
sequence).
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= To interrupt the autosampler when a sequence is not running, click
Stop on the Dionex AS-DV ePanel in Chromeleon 7 or the Dionex
AS-DV Control panel in Chromeleon 6.8.

NOTE After the Dionex AS-DV stops its current
operation, the carousel returns to the home
position (position 1). Do not reach into the
autosampler while the carousel is moving!

3.8.2 Specifying a Bleed

A bleed delivers excess sample (and any trapped air) from the vial to
waste, before delivering the injection volume to the sample loop or
concentrator column. Excess sample is any sample above the fill line on

the vial (see Figure 2-7).

You can use either the injection valve or an optional high-pressure valve
configured as an auxiliary valve to perform the bleed. For details about
plumbing a high-pressure valve as a bleed valve, see Section 2.2.3.

Enabling a Bleed

1. If you are creating a new instrument method or program, go to the
Sample Preparation Options page of the Instrument Method Wizard
or Program Wizard (see Figure 3-8).

If you are editing an existing instrument method or program, go to the
Sample Preparation page of the Instrument Method Editor or Program
Editor.

2. If you are using Basic Edit Mode: In the Bleed list, select the valve
position that will direct the bleed to waste. For the typical injection
valve plumbing, select InjectPosition (see Figure 3-8). For the
typical auxiliary valve plumbing, select AuxValve.A (see
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Figure 3-9). For suggested valve plumbing connections, see
“Plumbing the Optional Valve” on page 92.

Program Wizard: Sample Preparation Options

Loading Mode

* Loop Mode " Concentrator Mode
General Parameters

Delivery Speed: |4 mL/min Drelay Wolume: 125 pl

[ Cycle Time Flush Factar. |10 :‘
Edit Mode

i+ Basic

Yolume: |From Sequence v | Bleed:  |[TEisesian [ Rinze
" Advanced
Command | Parameters

InjectPaosition
D eliverS ample Walume=Bleed

| TPt

DeliverS ample

EndS amplePrep

Inject

< | > Q

el B A PR PR S R S g R,

Figure 3-8. Sample Preparation Options (Chromeleon 6.8 Version Shown):
Bleed Enabled Using the Injection Valve
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Program Wizard: Sample Preparation Options

Loading Maode

&+ Loop Mode " Concentrator Mode
General Parameters

Delivery Speed: |4 L /i Delay Wolume: 125 pL

[~ Cyele Time Flush Factor. |10 il
Edit Mode

“Wolume: |Fn:|m Sequenceﬂ Bleed: |.&u>:\r‘a|ve..-’-‘« j [ Ringe

" Advanced

Command —— | Parameters

AL alve s,

DeliverSample Wolurme=Blzed

T "

DeliverSample

EndSamplePrep

Inject

< > 4

o i okt bt o e Al g et it P e oot i el Bt KR i, o i A il il ol Bt e e . adh
Figure 3-9. Sample Preparation Options (Chromeleon 6.8 Version Shown):
Bleed Enabled Using the Auxiliary Valve

Selecting Bleed adds two commands to the Command/Parameters
table (see Figure 3-8 and Figure 3-9):

= The valve command switches the valve position to direct the
bleed volume to waste.

e The DeliverSample Volume=Bleed command delivers the
excess sample and trapped air from the vial to the valve.

3. Ifyou are using Advanced Edit Mode, manually add the two
commands described above to the Command/Parameters table.
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3.8.3 Specifying a Rinse

A rinse delivers rinse liquid from a vial to waste. To perform a rinse cycle,
the Dionex AS-DV needs the following information:

* The position of the vial containing the rinse liquid

e The volume to use for rinsing

Defining a Rinse Cycle

1. If you are creating a new instrument method or program, go to the
Sample Preparation Options page of the Instrument Method Wizard
or Program Wizard (see Figure 3-8).

If you are editing an existing instrument method or program, go to the
Sample Preparation page of the Instrument Method Editor or Program
Editor.

2. If you are using Basic Edit Mode: Select the Rinse check box and
enter the Volume (see Figure 3-10). With this mode, the rinse is
always delivered from the vials in the rinse vial range specified in the
Chromeleon 7 Instrument Configuration Manager or Chromeleon 6.8
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[ LaadPosition

Server Configuration program (see “Specifying the Rinse Vial
Position” on page 45).

Program Wizard: Sample Preparation Options

Loading Mode
* Loop Mode
General Farameters

Delivery Speed: |4 mlL/min
[ Cycle Time

Edit Mode
(* Basic

Volume: |From Sequence | Bleed: |Maone -
" Advanced

I jm] I,
Wolurme=1000, Position=Rinze

" Concentrator Mode

Delay Volume: 125 plL

Flush Factor: |10 i‘

v Rinze Yalume: 1000 « | pL

and

Co

InjectPosition
DeliveriRinse

DieliverSample
EndSamplePrep
Inject

1T

AR ok R

Figure 3-10. Sample Preparation Options (Chromeleon 6.8 Version Shown):

Deliver Rinse in Basic Edit Mode
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Selecting the Rinse check box and entering a Volume adds two
commands to the beginning of the Command/ Parameters table (see

Figure 3-10):

* The InjectPosition command switches the valve position,
directing the rinse volume to waste.

e The DeliverRinse command delivers the specified rinse Volume
from the Rinse vial to the valve.

3. Ifyou are using Advanced Edit Mode: Manually add the
InjectPosition and DeliverRinse commands described above to the
Command/ Parameters table (see Figure 3-11). With this mode, you
can deliver the rinse from any vial.

Program Wizard: Sample Preparation Options

Loading Mode

* Loop Mode " Concentrator Mode
General Parameters

Delivery Speed: ldi mL/min Delay Yolume: 125 pl

[ Cucle Time li Fluzh Factar: Im_:‘
Edit Mode

™ Basic

[Fiom Sequence <] iore =] T [1000 ~]
i+ Advanced

Command: |InjectPosition

I
Eﬂmand( | ararmeteT
< InjectPosition
DeliverRinge Yolume=100, Position=10
W Inzert
Delivers ample
EndS ampleFrep Append
Inject Modity
Delete
b »

L I B e I T e o e e o e S e, S R s o S,

Figure 3-11. Sample Preparation Options: Deliver Rinse in
Advanced Edit Mode (Chromeleon 6.8 Version Shown)
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Specifying the Rinse Vial Position

This section describes two methods for specifying a rinse vial position.

Method 1: Specify a vial in the rinse vial range

1.

To define the rinse vial range, start the Chromeleon 7 Instrument
Configuration Manager or Chromeleon 6.8 Server Configuration
program and open the AS-DV Properties dialog box. Click the
Options tab. Under Rinse Vial Range, define a range of vial
positions to be reserved for rinse vial use only (see Figure 3-12).

Dionex AS-D¥ Autosampler

General] State Devicesl TTL Inputz  Options lError Levels

Walve

P
Inigctian Label  [Ausiabee

o Ausiliary
" None

Drefault Injection Parameters

Drelay Walurme: 126yl

. 10—
Flush Factor: =

Total wolume delivered = [Injection Yolume + Delay Yolume] * Flush Factor

e Wial Fange

Start Position: 15 ﬂ

End Position; 50 =i

[ Sample Dverlap

- — = T

Figure 3-12. Dionex AS-DV Configuration Properties Dialog Box: Options

2.

Tab Page

In the Chromeleon instrument method or program, enter Rinse for the
vial position. See the example in Figure 3-10.

When the Dionex AS-DV performs the rinse, it takes the rinse liquid
from the first vial in the rinse vial range. If the first vial is empty, the
next vial in the range is used, and so on. If the specified rinse volume
is greater than a single vial volume, the Dionex AS-DV takes the
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volume from more than one vial. Verify that the specified volume is
available in the vials in the rinse vial range.

Method 2: Enter a specific vial position in the Chromeleon instrument
method or program.

1. On the Sample Preparation page of the Instrument Method
Wizard/Editor or Program Wizard/Editor, select Advanced Edit
Mode.
NOTE When you open the Sample Preparation page in the
Instrument Method Editor or Program Editor,
Advanced Edit Mode is selected by default.
2. Enter a DeliverRinse command and enter the preferred vial position.
Program File AS-DV - Sampler {AS-DV) M[=1E3
Title: |
oy Sample Preparation ]
n;:g’:'f Loading M ode
Tt * Loop Mode ™ Concentrator Mode
Commands General Parameters
Delivery Speed; |4 mL/min Delay Yolume: 125 pL
l [~ Cycle Time Flush Factor: |10 :l
. Egj E dit Mode
(105, 7800) £ Basic
. | =] elees | 4 R [fo00 ]
M . * pdvanced
I Command: |De|iverF|inse ﬂ Volume: |1DDD ﬂuL Wial: |1 -
[SAaSnEI\e;; Command | FParameters
|njectPosition
DeliverRinse Yolume=1000, Position=1
I LoadPogition Insert
Delivers ample
B ECD EndS ampleFrep Append
ump_| :
(1C5-T600) Iniect
Delete
= < : ¥

Figure 3-13. Sample Preparation Options: (Chromeleon 6.8 Version Shown)

Deliver Rinse Example
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3.8.4 Returning to a Vial

After sampling from other vials, you can return to a vial that was
previously sampled.

NOTE If a bleed is enabled, the Dionex AS-DV performs
the bleed function when it returns to the vial.
However, because the bleed was performed
previously, there is no excess fluid remaining in the
vial to exit during the second bleed cycle.

Open the sequence.

In the Position column, enter the position of the vial from which to
take each sample. For example, in the example sequence shown in
Figure 3-14, Sample 1 is taken from the vial in position 1. Samples 2
and 3 are taken from the vials in positions 2 and 3, respectively. For
Sample 4, the Dionex AS-DV returns to the vial in position 1.

Mo, | Marme Type Poz | Inj. %al. [Program Methiod Statu;
1 @ Sample 1 Unknowwn 1 250 AS DY AS1E_Trace  Singl
2 @ Sample 2 Unknowwn 2 250 AS DY AS1E_Trace  Singl
3 @ Sample 3 Unknowwn 3 250 AS DY AS1E_Trace  Singl
4 @ Sample 4 Unknowwn 1 250 AS DY AS1E_Trace  Singl

Figure 3-14. Chromeleon Sequence Example
(Chromeleon 6.8 Version Shown): Returning to a Vial

3.8.5 Replacing Vials During a Run

During a run, follow the steps below to remove vials that have already
been sampled and replace them with different vials.

1. Open the Dionex AS-DV ePanel (in Chromeleon 7) (see Figure 3-4)

or Control panel (in Chromeleon 6.8) (see Figure 3-5).

Under Reset Vial Memory, enter the Start Pos. and End Pos. of the
range of vials that you want to replace. For example, if vials 1
through 10 have already been run and you want to replace them with
new vials, enter 1 for the start position and 10 for the end position.

Click Reset Vial Range. This clears vial information (the size of the
vial installed, if any, and the volume remaining) for the specified
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3.8.6

positions. A message informs you that a queue or batch is currently
running. Click Yes to continue.

Wait until the Dionex AS-DV carousel and sampling tip are not
moving. Then lift the top cover, remove the old vials, and replace
them with the new vials. Do not reach into the autosampler while
the carousel is moving!

Inserting a Priority Sample

1.
2.

Open the currently running sequence.

To insert a priority sample, right-click the sample that you want the
priority sample to precede and select Insert Sample. This adds a new
sample to the sequence.

Enter injection information for the new sample and click File > Save.

If you are replacing a previously sampled vial with the priority vial,
follow these steps:

a. Open the Dionex AS-DV ePanel (in Chromeleon 7) (see
Figure 3-4) or Control panel (in Chromeleon 6.8) (see

Figure 3-5).

b. Under Reset Vial Memory, enter the position of the vial in the
Start Pos. and End Pos. boxes.

c. Click Reset Vial Range. This clears vial information (the size of
the vial installed, if any, and the volume remaining) for the
position. A message informs you that a batch is currently running.
Click Yes to continue.

Wait until the Dionex AS-DV carousel and sampling tip are not
moving. Then lift the top cover, remove the old vial (if any), and
insert the priority vial in the carousel. Do not reach into the
autosampler while the carousel is moving!
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3.8.7 Controlling the Delivery Volume

The Dionex AS-DV can deliver a full vial volume in one injection or
deliver a partial vial volume in multiple injections. Sample delivery
volume features vary, depending on the Edit Mode.

Controlling the Delivery Volume in Basic Edit Mode

1. On the Sample Preparation page of the Instrument Method

Wizard/Editor or Program Wizard/Editor, select Basic Edit Mode
(see Figure 3-15).

Program File AS-DV - Sampler (AS-DY)

Caommarnds

L

Purmp_ECD
[IES-1800]

-

(¥
I

Sampler
[&5-0%

Pump_ECD
[IE5-1800]

Fielay and State
Devices -

Sample Preparation l

Loading Mod
o L " Concentratar Mode
General Farameters
Delivery Speed: |4 L/t Delay Yolure: 125 pL
[ Cycle Time Fluzh Factor: 110 i‘
Edit Mode
* Basic
Vaolume: | Full w| Bleed: |Mone - [™ Binse
" Advanced
Cammand | Parameters
LoadPasition
DeliverS ample Yolume=Full

EndSamplePrep
Inject

11

< >
Total Volume Delivered E stimatar

[ Loop Yolume [uL) + Delay Yolume [pL] ) * Flush Factor = [uL]

Figure 3-15. Sample Preparation Options: (Chromeleon 6.8 Version Shown)

Basic Edit Mode
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2. Inthe Volume list, select the preferred option. The options available
in Basic Edit Mode are:

From Sequence: The Dionex AS-DV calculates the delivery
volume using the formula shown in the Total Volume Delivered
Estimator. See the example on page 52.

Full: The Dionex AS-DV delivers the full vial volume.

1666 pL: The Dionex AS-DV delivers 1666 pL from the vial.
Select this option if you want to take three injections from a
5000 pL vial.

2500 pL: The Dionex AS-DV delivers 2500 uL from the vial.
Use this option if you want to take two injections from a 5000 pL
vial.

Controlling the Delivery Volume in Advanced Edit Mode

1. On the Sample Preparation page of the Instrument Method
Wizard/Editor or Program Wizard/Editor, select Advanced Edit
Mode.

2. If you are creating a new instrument method or program, add a
DeliverSample command to the list of commands in the
Command/Parameter table.

3. If you are editing an existing instrument method or program, click the
Deliver Sample command in the list.

4. Inthe Volume list, select the preferred option. The options available
in Advanced Edit Mode are:

From Sequence: The Dionex AS-DV calculates the delivery
volume using the formula shown in the Total Volume Delivered
Estimator. See the example on page 52.

Bleed: The Dionex AS-DV performs a bleed. For details about
the bleed function, see “Enabling a Bleed” on page 39.

Full: The Dionex AS-DV delivers the full vial volume.

### uL: The Dionex AS-DV delivers the specified number of uL
from the vial. You can select the number of uL in 100 uL
increments. For 5.0 mL vials, you can select from 100 to
5000 pL. For 0.5 mL vials, you can select from 100 and 500 pL.

50
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For example, to take five injections from a filled 5.0 mL vial, select
1000 pL. In the instrument method Script or program Commands
view, a DeliverSample Volume=1000 command appears (see

Figure 3-16).

Mew Program File - Commands

Title: |

WY
Freeetim,
Fresmure

0 Fke 14
wE=
Iapect

Commands

®

Pump_ECD
(IC5-300)

-

(¥}

Sampler
[&a5-Din]

aaaaaaa

Pressure.LowerLimit = 0 [psi] ~
Pressure.Upperlimit = 5000 [p=i]
A, Equate = TEAT
DeliverSpeed = 4.0 [ml/min]
DelayVolume = 125 [pl]
FlushFactor = 10
Sampler.LoadPosition
<:::§Eiiyerﬁample Yolume=1000
EnddampleFrep
Flow = 0.50 [ml/fmin]
0.ooo Autozero
Wait CycleTimeState
Inject
ECD_1.AoqOn
30.000 ECD_1.acqgOff
End 3
>

<

Figure 3-16. Chromeleon 6.8 Commands View Example: Deliver Multiple Injections

Per Vial by Specifying the Volume

Notes:

The wizard adds the DelayVolume and FlushFactor commands to
the instrument method or program automatically. However, they are
ignored in this example. If a second DeliverSample command
(without a specified volume) were included, the DelayVolume and
FlushFactor commands would be used to calculate the volume for
the second DeliverSample command.

In the Script or Commands view, you can enter the Volume for the
DeliverSample command in 1 uL increments. For example, to take
three injections from a 5000 pL vial, enter the following command:
DeliverSample Volume=1666.
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Example: Using the From Sequence Volume Option

When From Sequence is selected for the sample delivery volume, the
Dionex AS-DV calculates the delivery volume using the formula shown
in the Total Volume Delivered Estimator. In this case, the
DeliverSample command is included without a specified volume.

In the example shown in Figure 3-17, the loop volume is 25 puL, the delay
volume is 125 pL (the default), and the flush factor is 8. This provides a
delivery volume of 1200 pL. This example allows four injections per

filled 5.0 mL vial.
New Program File - Sampler (AS-DY)
Ty Sample Preparation l
n,:_g;"; Loading Mode
ot "'_ + |oop Mode " Concentrator Mode
Commards General Parameters
Delivery Speed: |4 mL/mir Delap Wolume: 125 pL
l [~ Cpcle Time Flush Factar. 1@ :‘
JQ Edit Mode:
Pump_ECD i
(IC5-1600] & Fesic
- [From Sequence -] [Nore =] T [1000 -]
H . + Advanced
1 Command: | LoadPaosiion +
ﬁ;_.‘asnt'gl\i; Command | Parameters
LoadFosition
DieliverS ample
I EndSamplePrep
Inject
nes Append
Pump_ECD
{IES-1600)
< 2
Total % olume Delivered E stimator
Relay and Stej [LoopYolume |25 [uL) + Delay Yolume [pL] ] * Flush Factor = (L)
Devices

Figure 3-17. Sample Preparation Options (Chromeleon 6.8 Version Shown):
Estimating the Delivery Volume Example

Notes:

* In Loop Mode, you can increase or decrease the delivery volume by
entering a different Flush Factor.
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= When you create the sequence (see Section 3.6), enter the volume of
the loop installed on the injection valve in the Inj. Vol. box. The
Dionex AS-DV always injects a full loop volume.

3.8.8 Using Sample Overlap Mode

The Dionex AS-DV can be configured to overlap sample preparation
functions. This means that while data collection is occurring for one
injection, the Dionex AS-DV performs the sample preparation steps for
the next injection in the sequence. The overlapped steps include Dionex
AS-DV commands that occur before the EndSamplePrep command in
the instrument method or program.

For sample overlap to occur, the BeginOverlap command must also be
present in the instrument method or program. When sample overlap mode
is enabled (see page 55) and you use the Instrument Method Wizard or
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Program Wizard, Chromeleon automatically adds the EndSamplePrep
and BeginOverlap commands. See the example in Figure 3-18.

$A.BEquate = TEAT »~
DeliverS8peed = 4.0 [ml/min]
5 - DelayVolume = 125 [pl]
S FlushFactor = 10
Eommards Sampler.LoadPosition
DeliverSample
EndS3amplePrep >
ﬁ Data Collection Rate = 5.0 [Hz]
Purp_ECD CellTemperature. Nominal = 35.0 [°¢]
(ICS-1600) Buppressor_Type = None
. Buppressor_Current = 0 [ma]
m ECD_Total.3tep = 0.20 [s]
Y ECD_Total.Average = off
Channel Pressure. 3tep = 0.20 [=]
[iasn?gl\?; Channel Pressure.iverage = off
Flow = 1.00 [ml/min]
| 0.ooo Autozero
Wait CycleTimedtate
Pump_ECD Inject
(ICS-1600) ECD_1.AcqOn
ECD_Total.AcqOn
Channel Pressure.icqOn
Relay and State @egir@verlap >
Devices
30.000 ECD_1.AcqOff
It ECD_ Total.AeqOff
\‘-,"\ Channel Pressure.icqOff
Post-acquisiti
Ste?;;lsmon End &
< >

Figure 3-18. Chromeleon 6.8 Commands View Example:
Sample Overlap Enabled
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Enabling Sample Overlap Mode

In the Instrument Configuration Manager or Server Configuration
program, open the Dionex AS-DV Properties dialog box and click the

Options tab. Select the Sample Overlap check box (see Figure 3-19).

Dionex AS-DV Autosampler Pg|
General ] State Devices ] TTL Inputs  Options ] Error Levels ]
Walve
& 7=z Label: |.-’-‘«u>:\n‘a|ve
o« Auiliany
" Maone
Default Injection Parameters
Drelay Walume: 125yl
: 0=
Fluzh Factor: =
Total volume delivered = [Injection Yolume + Delay Yolume] * Fluzh Factor
Rinze Wial Range
Start Position: 45 j
4 50—
End Position: =l
v Sample Overlap
0k | Cancel | | Help

Figure 3-19. Dionex AS-DV Configuration Properties: Options Tab Page

with Sample Overlap Enabled
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3.9 Routine Maintenance

This section describes routine maintenance procedures that the user can perform
for the Dionex AS-DV. Any maintenance procedures for the Dionex AS-DV that
are not described here must be performed by Thermo Fisher Scientific personnel.
For assistance, contact Technical Support for Dionex products. In the U.S. and
Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest
Thermo Fisher Scientific office.

3.9.1 Periodic Maintenance
* Periodically check the carousel and wipe up any spills.

= Periodically rinse off any dried spills.

3.9.2 Annual Maintenance
= Rebuild the optional high-pressure valve (see Section 5.5).

* Replace the sampling tip and the tubing between the tip and the valve.
The Dionex AS-DV Preventive Maintenance Kit (P/N 072678)
contains all of the components required. Instructions are included
with the Kit.
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4.1

This chapter is a guide to troubleshooting problems that may occur while

operating the Dionex AS-DV.

e Section 4.1 describes the error messages displayed in the Chromeleon audit

trail.

= Section 4.2 through Section 4.8 describe other operating problems and how to
resolve them.

If you are unable to solve a problem by following the instructions here, contact
Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-
6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific

office.

Alarms and Error Conditions

If any of the following alarm conditions occurs, an error message is displayed in
the Chromeleon audit trail. Each error message is preceded by an icon that
identifies the seriousness of the underlying problem (see the table below).

Icon

®
A

Severity Level
Warning

Error

Abort

Description

A message is displayed in the audit trail, but the
current run is not interrupted.

A message is displayed in the audit trail and the
system attempts to correct the problem (sometimes
by using an alternative parameter). An Error never
interrupts the current analysis; however, if it occurs
during the Ready Check, the analysis will not be
started.

A message is displayed in the audit trail and the
running batch is aborted.
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The table below lists the Dionex AS-DV error messages. For troubleshooting

assistance, refer to the page indicated in the table.

Alarms and Error Conditions

Attempt to deliver an invalid vial.
Attempt to reset vials while needle is not home.
Commanded carousel position cannot be found.

The Carousel Engage switch is inhibited during
deliver.

Carousel or needle is busy.

More rinse volume than remaining has been
requested.

The motor speed is reduced to ¥ of the previous one
because of excessive load.

Needle is jammed.
Not enough volume to deliver.
Sample needle failed to reach destination.

This command is not allowed at this stage because
the autosampler is busy.

TTL triggered while another command is in progress.

Valve error.
The vial is misaligned during deliver.

The vial size has been changed without resetting the
carousel.

Default Severity = See

Level
Error
Warning
Abort
Warning

Abort
Abort

Warning

Abort
Error
Error
Abort

Warning
Abort
Error
Warning

page 59
page 59
page 59
page 60

page 60
page 60

page 60

page 61
page 61
page 61
page 62

page 62
page 62
page 63
page 64
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A Attempt to deliver an invalid vial.

This error occurs if a vial is not placed in the position specified in the
instrument method or program, or if the vial position has been reset after the
vial is already depleted.

To troubleshoot:

1. Verify that a vial with a cap installed has been inserted into the specified
position.

2. Verify that sample remains in the vial.

3. Ifthe problem persists, contact Technical Support for Dionex products for
assistance.

@ Attempt to reset vials while needle is not home.

This error occurs if you attempt to reset vial memory, either by pressing the
Carousel Release button or clicking a Reset Vial Memory button on the
Dionex AS-DV Control panel (see Figure 3-5), when the needle is down.

To troubleshoot:
1. Wait until the needle is raised (homed) before resetting vial memory.

2. If the problem persists, contact Technical Support for Dionex products for
assistance.

@ Commanded carousel position cannot be found.

This error can occur if the carousel is jammed or the vial sensor has failed.
To troubleshoot:

1. Pressthe Carousel Release button to release the carousel.

2. Check the carousel for blockages (see Section 5.2).

3. If the problem persists, contact Technical Support for Dionex products for
assistance.
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®

The Carousel Engage switch is inhibited during deliver.

This error occurs if you press the Carousel Release button while a sample is
being delivered.

To troubleshoot:

Wait for a function to finish before trying to release the carousel.

Carousel or needle is busy.

This error occurs if you send a command while the carousel or needle is
performing a function.

To troubleshoot:

Wait for one function to finish before issuing a command to begin another.

More rinse volume than remaining has been requested.

This error occurs if there is not enough liquid in the vials in the rinse vial
range or in the specified vial (if a single vial is specified for the rinse).

To troubleshoot:
1. Pressthe Carousel Release button to clear the error and reset the system.
2. Install filled vials in the rinse vial range or in the specified position.

3. Begin the sampling process again.

The motor speed is reduced to ¥4 of the previous one
because of excessive load.

This error occurs when the needle is jammed or there is excessive
backpressure. The motor speed is reduced and the Dionex AS-DV attempts to
continue delivery. If the problem persists, the run is stopped, and the “Needle
is jammed” error message is displayed. For troubleshooting, refer to the
“Needle is jammed” section below.
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@ Needle is jammed.

This error occurs when the needle is jammed or there is excessive
backpressure.

To troubleshoot:

1. Pressthe Carousel Release button to release the carousel and raise the
needle. If the needle does not raise automatically, manually raise the
needle (see Section 5.4).

2. Check for blockages.
Check for excessive backpressure (see Section 4.7).

4. Ifthe problem persists, contact Technical Support for Dionex products for
assistance.

A Not enough volume to deliver.

This error occurs when there is insufficient liquid in the vial to deliver the
requested volume.

To troubleshoot:

Add more sample to the vial or select a smaller volume in Chromeleon (see
Section 3.8.7).

A Sample needle failed to reach destination.

This error occurs when the carousel is blocked or the sample head is jammed.
To troubleshoot:

1. Remove the carousel (see Section 5.2) and examine for blockages.

2. If the problem persists, replace the sampling tip (see Section 5.3).

3. If the problem continues, contact Technical Support for Dionex products
for assistance.
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This command is not allowed at this stage because the
autosampler is busy.

This error occurs when a command is sent while the autosampler is
performing another function.

To troubleshoot:
Wait for one function to finish before issuing a command to begin another.

TTL triggered while another command is in progress.

This error occurs if a controlling device sends a signal to the TTL input while
the Dionex AS-DV is already performing a command.

To troubleshoot:

1. After the other command is completed, send the signal to the TTL input
again. For details about the time required to complete the sample load
cycle, refer to Section C.1.1.

2. Ifthe problem persists, contact Technical Support for Dionex products for
assistance.

Valve error.

This error occurs if the optional high-pressure valve is not connected properly
or if the valve fails to switch position within 1 second of being toggled.

To troubleshoot:

1. Check the valve connections:

a. Start the Chromeleon 7 Instrument Configuration Manager or the
Chromeleon 6.8 Server Configuration program:

e For Chromeleon 7, click Start on the Windows taskbar and click
All Programs > Chromeleon 7 > Instrument Configuration
Manager.

e For Chromeleon 6.8, click Start on the Windows taskbar and
click All Programs > Chromeleon > Server Configuration.
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2.

3.

b. In the instrument or timebase, double-click the Dionex AS-DV icon
to open the Dionex AS-DV Properties dialog box.

c. Select the Options tab. If the Valve Injection and Auxiliary options
are unavailable, the valve is probably not connected properly.

d. Remove the valve (see Section 5.6) and verify that the cable
connection is secure. When reinstalling, be sure to tighten the screws
connecting the valve to the chassis to prevent any movement.

Toggle the valve positions:

a. Ifasequence is being executed, terminate the sequence by clicking
Batch > Stop on the Chromeleon menu bar.

b. Turn off the Dionex AS-DV power briefly and then restart.

NOTE Turning off the Dionex AS-DV power does not reset
vial memory.

c. On the Dionex AS-DV ePanel or Control panel, try to toggle the
valve position by clicking first the Load Position (or Position A)
button and then the Inject Position (or Position B) button.

If the error recurs, rebuild the valve (see Section 5.5).

A The vial is misaligned during deliver.

This error occurs if the carousel jams or the vial sensor fails.

To troubleshoot:

1.
2.

Press the Carousel Release button to release the carousel.

Check that the vial has been inserted completely into the carousel and
there is nothing blocking the vial.

Remove the carousel and check for blockages (see Section 5.2).

If the problem persists, contact Technical Support for Dionex products for
assistance.
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®

The vial size has been changed without resetting the
carousel.

This error occurs if there is a discrepancy between the vial size installed in the
carousel and the vial size currently stored in Dionex AS-DV memory. (For
example, a 5.0 mL vial is installed in position 10, but the Dionex AS-DV
expects a 0.5 mL vial to be installed in that position.) Vial memory must be
reset before starting a new run.

To troubleshoot:

1. Before starting a new run, press the Carousel Release button to reset the
vial memory.

2. If you want to replace vials during a run, use the controls on the Dionex
AS-DV ePanel (in Chromeleon 7) or Control panel (in Chromeleon 6.8)
under Reset Vial Memory to reset the memory for only the vials you
want to replace. For instructions, see Section 3.8.5.

3. If the problem persists, contact Technical Support for Dionex products for
assistance.

IMPORTANT] Before starting a run, always press the Carousel Release button to
disengage the carousel and reset vial memory. After loading the vials

in the carousel, press the Carousel Release button again to engage
the carousel.

During a run, do not press the Carousel Release button. Doing so
clears all current vial information from Dionex AS-DV memory. During
arun, the Dionex AS-DV stores the vial size installed in each carousel
position and the remaining volume in each vial.

4.2 Liquid Leaks

Old, previously-used caps or sample vials
Do not reuse caps or sample vials.

Damaged tubing between sampling tip and optional high-pressure valve
in the Dionex AS-DV or injection valve in the IC system

Replace the sampling tip and tubing (see Section 5.3).
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Loose or damaged fitting connection(s) to optional high-pressure valve in
the Dionex AS-DV or injection valve in the IC system

1. Make sure the liquid lines to the valve are tight. Replace any damaged
fittings. See Section 5.1 for tightening requirements.

2. Liquid leaks from behind the valve stator may indicate a scratched rotor
seal. Rebuild the injection valve (see Section 5.5). Do not overtighten!

4.3 Poor Peak Reproducibility

Insufficient sample in sample vial

Always be sure to fill each vial with enough sample to reach the fill line (see
Section 3.1). Underfilling a vial will result in a smaller than normal volume
for the first injection and will increase the risk of injecting air.

If the problem continues, overfill the vial slightly. After pushing the cap into
the vial, gently tap any excess liquid from the fill cap socket.

Bleed function not turned on when loading a concentrator column

Before loading concentrator column, check that Bleed is selected in
Chromeleon (see Section 3.8.2). This ensures that a uniform sample volume is
delivered to the concentrator, regardless of how accurately the vials are filled.
Bleed also prevents the introduction of air onto the concentrator column. It
does not, however, compensate for underfilling a sample vial.

(TTL Input Control Only) Injection not made during homing delay
before sample tip is retracted from sample

1. Always switch the injection valve to Inject before the end of the homing
delay following the last sample in the vial (see Section C.1). Otherwise,
the needle may create a vacuum when it withdraws from the vial and
remove some or all of the sample from the sample loop.

2. Make sure that the injection valve is in Load whenever a sample delivery
is in progress.
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Liquid leak

1. Do not reuse caps or sample vials.

2. Inspect the lip and socket of each new cap for irregularities, nicks,
scratches, or other damage that might interfere with sealing as the cap is
pushed into the vial.

3. Make sure that the sampling tip is not damaged. Replace the tip if it is

scratched, damaged, plugged, or restricted in any way (see Section 5.3).

Dissolved gas in samples

If the sample contains dissolved gas, it will produce peak area reductions. You
can observe bubbles in the sample line during injections.

1.
2.

Degas your sample with a vacuum filter or sonicate the samples.

Before sampling from the vial, perform a bleed to direct excess sample
and any air trapped in the vial to waste. For instructions, see

Section 3.8.2. The bleed can be performed using either the injection valve
or an optional high-pressure valve.

If you are making multiple injections per vial, make them sequentially.
This allows the needle to remain in the vial between injections, thus
preventing air from entering the sample.

4.4 Unexpected or Extraneous Peaks Detected

Sample contaminated

1.
2.

Never reuse sample vials and caps.

Always rinse new PolyVials and caps with deionized water before filling,
especially when doing trace-level analyses (see Section 3.1).

Run a rinse between samples, especially if samples are very different
from each other.

4.5 Sample Not Loaded

TTL input not connected (if used)

During remote operation, make sure the TTL input cable is securely
connected (see Appendix C).
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USB cable not connected

Make sure the USB cable is securely connected between the Dionex AS-DV
and the Chromeleon PC or IC system.

Vial not sensed

1. Make sure that a cap is installed in each PolyVial. Vials without caps are
sensed as empty positions (see Section 2.2.1).

2. The vial detection sensors are blocked, dirty, or faulty. Contact Technical
Support for Dionex products for assistance.

4.6 Autosampler Stops Operating

Sample loading backpressure exceeds 690 kPa (100 psi)
Refer to Section 4.7 to isolate and eliminate the source of backpressure.
Autosampler is jammed

In the event of a jam, the alarm will flash and an error will be recorded in the
Chromeleon audit trail. See Section 4.8 for troubleshooting.

4.7 Excessive Backpressure

Injection valve in wrong position

On the Dionex AS-DV ePanel (in Chromeleon 7) or Control panel on the
panel tabset (in Chromeleon 6.8), toggle the valve position.

Restriction in the liquid flow path

1. If the high backpressure persists, follow the liquid flow path backward
from the injection valve, through the high-pressure valve (if installed),
loosening fittings and reconnecting them until you locate the restriction.

2. If the restriction is in the optional high-pressure valve or the injection
valve of the IC system, disassemble the valve and rebuild it (see
Section 5.5). Inspect the port faces and replace them if necessary (see
Section 5.6).

3. If the restriction is in the sampling tip (or the tubing between the valve
and the sampling tip), replace the sampling tip (see Section 5.3).
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e Sample is viscous

Reduce the delivery speed by 20% or more in the Chromeleon instrument
method or program (see Section 3.5).

4.8 Autosampler Jammed

* Vial carousel is jammed
1. Press the Carousel Release button to try to home the carousel.
2. Remove the carousel (see Section 5.2) and check for foreign objects.
e Sampling tip jams as it is being withdrawn
1. Check for excessive backpressure (see Section 4.7).
2. Check the sampling tip for possible obstruction:
a. Turn off the power to the Dionex AS-DV.
b. Manually raise the sampling head (see Section 5.4).
c. Check for blockages.
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This chapter describes Dionex AS-DV service and repair procedures that users
may perform. Procedures not included here, including electronics-related repair
procedures, must be performed by Thermo Fisher Scientific personnel. For
assistance, contact Technical Support for Dionex products. In the U.S. and
Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest
Thermo Fisher Scientific office.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to
correctly identify the cause of the problem.

Substituting non-Dionex/Thermo Scientific parts may impair a module’s
lIMPORTANTl performance, thereby voiding the product warranty. Refer to the

warranty statement in the Dionex Terms and Conditions for more
information.

5.1 Replacing Tubing and Fittings

The Dionex AS-DV is plumbed with the needle and tubing assembly listed below:

Tubing Assembly Used for
Dionex AS-DV Sampling Tip Kit Connection from sampling head to
(P/N 071575) injection valve

Dionex AS-DVtubing connections use high-pressure 10-32 fitting bolts
(P/N 074449) and high-pressure double-cone ferrules (P/N 074373).

To tighten a high-pressure fitting bolt and ferrule:
1. Use your fingers to tighten the fitting bolt as tight as you can.

2. Then, use a wrench to tighten the fitting an additional three-quarter turn
(270 degrees).

3. If leaks occur, replace the fitting bolt, ferrule, and tubing.
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5.2

Removing the Carousel

The following tools are needed to complete this procedure: #1 Phillips
screwdriver, 3-mm Allen wrench, and 2.5-mm Allen wrench.

1. Press the Carousel Release button to raise the sampling tip to its fully up
position.

2. Turn off the Dionex AS-DVpower and disconnect the power cord. Raise the
top cover.

3. Remove the Dionex AS-DV front cover by gripping the indentations at each
side and pulling the cover straight off toward you.

4. Use a#1 Phillips screwdriver to remove the three flathead screws from the
sampling head tower cover (see Figure 5-1). Lift up the cover to remove it.

Sampling
~ Head Tower'

Figure 5-1. Removing the Sampling Head Tower Cover
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5. Usea3-mm Allen wrench to
remove the set screw on the
sampling head (see
Figure 5-2).

6. Pull slightly on the sample
out line to gain a small
amount of slack in the line.
Then, slide the tubing out of
the slot in the sampling head

(see Figure 5-3).

7. Push down on the sampling
head to move the needle into
the carousel a small amount.
Twist the needle to allow the
sampling tip to exit through
the opening in the sensor
block.

Sampling
Head

Remove the
set screw

Figure 5-2. Removing the Set Screw

o

Slide the

¥ line out of

the slot -

Sensor Block

Figure 5-3. Sliding the Sample Out Line
Out of the Sampling Head Slot
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8. Lift the needle out of the carousel and set it to the right (see Figure 5-4).

Lift the
needle

Set the
needle to
the right

Figure 5-4. Lifting the Needle Out of the Carousel

9. Usea?2.5-mm Allen
wrench to remove the
three screws on the
sensor block (see
Figure 5-5). Lift the
sensor block off the
carousel and set it to the
right.

Remove 3
screws

Sensor
Block

Figure 5-5. Removing the Sensor Block
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10.

11.
12.

13.

14.

15.

16.

17.
18.
19.

Unscrew the thumbscrew
on the carousel, and lift the
carousel out of the
autosampler.

Figure 5-6. Removing the Carousel

Clear any blockages and clean the basin.

Align the holes on the bottom of the carousel
with the pins on the top of the carousel shaft
and reinstall the carousel. Replace the
thumbscrew and hand tighten.

Slide the needle tubing back into the slot in the
sampling head.

Reinstall the sensor block.

Align the flat sides of the sampling tip so that
they fit through the opening in the sensor
block.

Make sure that the needle is pushed as far as it
will go up into the sampling head and then Opening in
tighten the set screw firmly. b SR B!k

NOTE The set screw must be very tight to
secure the sampling needle.

Reinstall the sampling head tower cover.
Reinstall the front cover and close the top cover.

Reconnect the power cord and turn on the power.
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5.3

Replacing the Sampling Tip and Tubing

A scratched or otherwise damaged sampling tip may result in poor transfer of
liquid from the sample vial to the injection valve. Damage to the tubing between
the tip and the injection valve may result in liquid leaks. If you replace the
sampling tip, you must also replace the tubing between the tip and the injection
valve or optional high-pressure valve.

The Dionex AS-DV Sampling Tip Kit (P/N 071575) contains all required parts.

The following tools are needed to complete this procedure: #1 Phillips
screwdriver and 3-mm Allen wrench.

1. Disconnect the sample out line from the injection valve or optional high-
pressure valve. Remove the fitting.

2. Press the Carousel Release button to retract the sampling tip to its fully up
position.

3. Turn off the Dionex AS-DV power and disconnect the power cord. Raise the
top cover.

4. Remove the Dionex AS-DV front cover by gripping the indentations at each
side and pulling the cover straight off toward you.

5. Use a #1 Phillips screwdriver to remove the three flathead screws from the
sampling head tower cover (see Figure 5-7). Lift up the cover to remove it.

]

Sampling ¥
Head Tower|
s

1 Remove 3 screws -
" }!IIIII!'I

—

e — AN by

o, (6N

Figure 5-7. Removing the Sampling Head Tower Cover
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6. Usea3-mm Allenwrench to
remove the set screw on the
sampling head (see
Figure 5-8).

7. Pull slightly on the sample
out line to gain a small
amount of slack in the line.
Then, slide the tubing out of
the slot in the sampling head

(see Figure 5-9).

8. Push down on the sampling
head to move the needle into
the carousel a small amount.
Twist the needle to allow the
sampling tip to exit through
the opening in the sensor
block.

Sampling
Head

Remove the
set screw

Figure 5-8. Removing the Set Screw

-~

Slide the

— line out of

the slot -

Sensor Block

Figure 5-9. Sliding the Sample Out Line
Out of the Sampling Head Slot

9. Unscrew the sampling tip from the needle and pull out and discard the tip and

tubing.

10. Locate the sampling tip assembly in the kit. This assembly consists of a length
of tubing with a new sampling tip installed on one end.
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11.

12.

13.

14.

15.

16.
17.
18.
19.

Thread the free end of the tubing up through the needle and
screw the tip into place on the needle.

Continue threading the free end of the tubing up through
the sampling head and out the aperture on the front of the
Dionex AS-DV.

Slide the needle into place and slide the sampling needle tubing back into the
slot in the sampling head.

Align the flat sides of the sampling tip so that
they fit through the opening in the sensor
block.

Make sure that the needle is pushed as far as it
will go up into the sampling head and then Opening in
tighten the set screw firmly. \e S no Ik

NOTE The set screw must be very tight to
secure the sampling needle.

Reinstall the sampling head tower cover.
Reinstall the front cover and close the top cover.
Reconnect the sample out line to the valve.

Reconnect the power cord and turn on the power.
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5.4 Manually Raising the Sampling Head
Follow this procedure if you need to raise the sampling head out of the carousel
manually (for example, to clear a needle jam).

The following tools are needed to complete this procedure: #1 Phillips
screwdriver and 2.5-mm Allen wrench.

1. Turn off the Dionex AS-DVpower and disconnect the power cord. Raise the
top cover.

2. Remove the Dionex AS-DV front cover by gripping the indentations at each
side and pulling the cover straight off toward you.

3. Use a #1 Phillips screwdriver to remove the three flathead screws from the
sampling head tower cover (see Figure 5-1). Lift up the cover to remove it.

Sampling
/ Head Tower'

Figure 5-10. Removing the Sampling Head Tower Cover
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10.

Insert a 2.5-mm Allen wrench into
the screw on top of the sampling
mechanism (see Figure 5-11) and
turn the wrench clockwise. The
needle begins moving up.

Continue turning the wrench until
the top of the sampling head is
even with the top of the sampling
mechanism.

If you are clearing a needle jam,
remove the obstruction from the
carousel.

Sampling :
Mechanism . €

Figure 5-11. Manually Raising the Sampling Head

Turn the wrench counterclockwise
to begin lowering the needle. Turn
the wrench until the top of the
sampling head is about 6 mm

(1/4 in) below the top of the
sampling mechanism (see

Figure 5-12).

Sampling

Mechanism SampE

Head

Figure 5-12. Lowering the Sampling Head

Before Turning on the Power

Reinstall the sampling head tower cover.

Reinstall the front cover and close the top cover.

Reconnect the power cord and turn on the power switch.
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5.5 Rebuilding a High-Pressure Valve

Thermo Scientific recommends rebuilding the optional high-pressure valve
annually or if problems occur and other troubleshooting steps do not resolve the
problem. The Injection Valve Rebuild Kit (6-port valve, P/N 075973; 10-port

valve, P/N 079054) contains all required parts.

NOTE Substitution of non-Dionex/Thermo Scientific parts may
impair valve performance and void the product

warranty.

NOTE If you prefer, you can replace the high-pressure valve
“pod” (see Section 5.6) instead of rebuilding the valve.

The following tool is needed to complete this procedure: 3-mm Allen wrench.
1. Turn off the Dionex AS-DVpower.

The Dionex AS-DV power must be turned off before you rebuild a
valve. If the power is on when you disconnect or connect the valve

cable, the Dionex AS-DV will be damaged.
CAUTION
2. Raise the top cover.

3. Remove the Dionex AS-DVfront cover by gripping the indentations at each
side and pulling the cover straight off toward you.

4. Disconnect each liquid line connected to the valve.
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5. Remove the 6-port or 10-port high-pressure valve:

a. Use a 3-mm Allen wrench to remove the two screws holding the valve
assembly in place (see Figure 5-13).

) Remove these
2 screws

Figure 5-13. Removing the Valve Assembly

b. Slide the valve assembly partway out of the chassis, press the locking
latch on the cable (see Figure 5-14), and disconnect the cable.

Locking Latch

Figure 5-14. Disconnecting the Valve Cable

c. Remove the valve assembly.

6. Follow the instructions provided in the Rebuild Kit to replace the rotor seal,
isolation seal, and stator face.
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7. Reinstall the valve assembly and reconnect all liquid lines.
8. Turn on the power to the Dionex AS-DV.
9. Start a test run to check for leaks from the valve. Tighten fittings as required.

10. Reinstall the front cover and close the top cover.

5.6 Replacing a High-Pressure Valve Pod

This procedure describes how to replace the mechanical parts (the “pod”) of an
optional high-pressure valve.

NOTE Substitution of non-Dionex/Thermo Scientific parts may
impair valve performance and void the product
warranty.

The following tool is needed to complete this procedure: 3-mm Allen wrench.
1. Turn off the Dionex AS-DV power.

The Dionex AS-DV power must be turned off before you replace a
valve pod. If the power is on when you disconnect or connect the

valve cable, the Dionex AS-DV may be damaged.
CAUTION

2. Raise the top cover.

3. Remove the Dionex AS-DV front cover by gripping the indentations at each
side and pulling the cover straight off toward you.

4. Disconnect each liquid line connected to the valve.
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5. Remove the 6-port or 10-port high-pressure valve:

a. Use a 3-mm Allen wrench to remove the two screws holding the valve
assembly in place (see Figure 5-15).

Remove these

® _ 2 screws L]

Black
Locking Ring

Figure 5-15. Removing the Valve Assembly

b. Slide the valve assembly partway out of the chassis, press the locking
latch on the cable (see Figure 5-16), and disconnect the valve cable.

Locking Latch

Figure 5-16. Disconnecting the Valve Cable

c. Remove the valve assembly.

6. Unscrew the black locking ring on the front of the valve (see Figure 5-15) and
remove the ring.
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7.
8.

Grasp the front of the valve pod and pull out firmly to remove it.

Align the slots in the new pod (6-port, P/N 075971; 10-port, P/N 075972)
with the runner in the valve holder. Valve pods are keyed to fit only one way
(one slot is narrower than the other). Verify that the slots are aligned with their
matching runners.

Also verify that the two splines on the pod align with the matching splines
inside the valve holder (see Figure 5-17). If necessary, twist the end of the pod
to adjust the position of the splines.

Runner (Larger)

Splines

Valve Pod Valve Holder

10.

11.
12.
13.
14.

Figure 5-17. Valve Pod and Pod Holder

Push the pod into the holder until it clicks into place. Replace the black
locking ring.

Reinstall the valve assembly and reconnect all liquid lines.
Turn on the power to the Dionex AS-DV.
Start a test run to check for leaks from the valve. Tighten fittings as required.

Reinstall the front cover and close the top cover.
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5.7 Replacing the Main Power Fuses

1. Turn off the power switch on the Dionex AS-DV rear panel (see Figure 5-18).

2. Disconnect the main power cord from both its source and from the Dionex
AS-DV rear panel.

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the Dionex AS-DV.

DANGER
HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arriere du Dionex AS-DV.

DANGER
HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Riickseite des Dionex AS-DV.

ACHTUNG

3. The fuse drawer is located below the main power switch (see Figure 5-18).

4. Arecessed lock is located on each side of
the fuse drawer. Use a small screwdriver

(or your fingernail) to push each lock i Tower

toward the center to release it. When both

locks are released, pull the fuse drawer Fuse

straight out of its compartment. Drawer
5. Replace the two fuses with new 3.15 A

IEC 127 fast-blow fuses (P/N 954745).

Thermo Scientific recommends always Locks

replacing both fuses.

Figure 5-18. Dionex AS-DV Fuse Drawer

6. Insert the fuse drawer into its compartment. Apply sufficient pressure evenly
against the drawer to engage the two locks. The drawer will be flush against
the panel when both locks are engaged.

7. Reconnect the main power cord and turn on the power.
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A.1 Electrical

Main Power

Fuses

A.2 Physical

Dimensions

Weight

100 to 240 Vac, 50 to 60 Hz, 45 W
Typical input power: 15 W
Maximum line draw: 0.22 A at 110 Vac

Two fast-blow IEC 127 fuses rated at 3.15 A (P/N 954745)

Width: 44.45 cm (17.5 in)
Height: 23 cm (9 in)
Depth: 56 cm (22 in)

16 kg (35 Ibs)

A.3 Environmental

Operating
Temperature

Humidity

10 to 35 °C (50 to 95 °F)

5% to 95% relative humidity, noncondensing
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A.4 Sampling Mechanism

Carousel
Sample
Capacity

Materials

Delivery Type

Number of
Samples

Minimum
Volume
Delivered

Valve
(Optional)

50 vials

All wetted surfaces are chemically inert plastic (polypropylene,
polyethylene, polytetrafluoroethylene, PEEK™, Tefzel®, or Kel-
F®)

Programmable in Chromeleon: From 0.1 mL/min to 5.0 mL/min

50

0.1 mL

6-port or 10-port 2-position valve with PEEK wetted components;
electrically-activated

A.5 Sample Vials

Volume

Filter
(Optional)

Material
Contamination
Levels

Special Features

0.5 mL and 5.0 mL, nominal

20 pm, nominal

Pharmaceutical-grade polypropylene vial and polyethylene cap,
sintered polyethylene filter

Less than 3.0 ppb fluoride, chloride, nitrate, and phosphate;
8.0 ppb sulfate

Concave cap directs air out of the vial; convex vial bottom mates
with the cap to allow maximum delivery of sample
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This chapter provides instructions for the initial installation of the Dionex AS-

DV.

NOTE The order of the steps is important. It is especially
important to install the Chromeleon Chromatography
Data System before connecting the USB cable and
turning on the system power.

B.1 Facility Requirements

Make sure the Dionex AS-DV installation site meets the electrical and
environmental specifications listed in Appendix A.

Refer to the dimension specifications in Appendix A to determine the amount
of bench space required. For optimum operation, place the Dionex AS-DV
close as possible to the left side of the IC system.

Allow at least 38 cm (15 in) of free space behind the Dionex AS-DV for
connections and ventilation.

Be sure that there is sufficient clearance above the Dionex AS-DVto allow the
top cover to be opened or removed.

B.2 Unpacking the Dionex AS-DV

1.

Open the Dionex AS-DV shipping container. Remove the autosampler and
place it on the workbench.

Unpack the Dionex AS-DV Ship Kit (for 0.5 mL vials, P/N AAA-071115; for
5.0 mL vials, P/N 068887) and all other items included in the shipping
container. Place the items in a convenient location and check them against the
packing list. Report any discrepancies to Thermo Fisher Scientific
immediately.
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3. Check the shipping container for any external signs of damage. If the
container shows any sign of damage, contact Thermo Scientific immediately.

Save the shipping container for later use. Should it be necessary to
return the Dionex AS-DV during the warranty period, Thermo Fisher
Scientific recommends repacking the autosampler in the original
shipping container.

4. Repeat the steps above for any additional shipping containers.

B.3 Connecting the Dionex AS-DV Sample Out Line

NOTE To prevent possible contamination of the tubing and
valve, Thermo Fisher Scientific recommends that you
wear gloves while connecting the Dionex AS-DV sample
out line.

1. Raise the Dionex AS-DV top cover.

2. Remove the Dionex AS-DV front cover by gripping the indentations at each
side and pulling the cover straight off toward you.

The sample out line is threaded through an aperture in the chassis (see

Figure B-1).

Sample Out
Line

j
* - -
| IIIII" o\

Figure B-1. Sample Out Line
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Two connection options are available:

e Connect the Dionex AS-DV sample out line directly to the injection valve in
the IC system (see Section B.3.1).

e Connect the Dionex AS-DV sample out line to an optional 6-port or 10-port
high-pressure valve installed in the Dionex AS-DV (see Section B.3.2).

B.3.1 Connecting the Sample Out Line Directly to an IC System

1. Route the sample out line through the side slot in the Dionex AS-DV
chassis. Leave a little slack in the tubing.

Route sample
out linethrough
side slotto IC
system

1
i —

—— —

Figure B-2. Routing the Dionex AS-DV Sample Out Line to an IC System

2. Locate a 10-32 fitting bolt (P/N 074449) and
double-cone ferrule (P/N 074373) in the Dionex
AS-DV Ship Kit (for 0.5 mL vials, P/N AAA-
071115; for 5.0 mL vials, P/N 068887).

3. Install the fitting and ferrule onto the end of the
Dionex AS-DV sample out line. See Section 5.1
for installation and tightening requirements.
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4. Connectthe Dionex AS-DV
sample out line to the
sample in port on the IC
system injection valve (see

Figure B-3).

5. Replace the front panel and
close the top cover on the
Dionex AS-DV.

Go on to Section B.4.

Dionex AS-
DV Sample
Qut Line

Figure B-3. IC System Injection Valve

B.3.2 Connecting the Sample Out Line to the Optional High-

Pressure Valve

Installing the Optional Valve

1. Verify that the power to the Dionex AS-DV is off.

The Dionex AS-DV power must be turned off before you install a valve.
If the power is on when you connect or disconnect the valve cable, the

Dionex AS-DV will be damaged.
CAUTION

2. Use a 3-mm Allen wrench to
remove the two screws
holding the valve cover plate

to the chassis. Save the screws.

L7
Remove these
2screws o

T
i —
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3. Reach inside the recess and
gently pull the electrical cable
until it extends out the front of
the autosampler.

4. Remove the 6-port or 10-port
valve from the Dionex AS-DV
Valve Kit (6-port, P/N 068920;
10-port, P/N 068921).

5. Align the electrical cable with
the connector on the back of

the valve (see Figure B-4).

6. Press the cable’s locking latch and insert the cable into the connector
on the valve until you hear a click.

Locking Latch

Figure B-4. Connecting the Valve Cable

7. Slide the valve assembly into the
valve recess, making sure not to
pinch the cable.

8. Use the two screws you removed
from the valve cover plate to
secure the valve onto the chassis.
Hand tighten.

Doc. 065259-05 10/12 91



Dionex AS-DV Operator’s Manual

Plumbing the Optional Valve

The plumbing configuration for the valve depends on the components to
be connected and the intended function. This section provides instructions
for the following configurations:

* Plumbing the 6-port valve as an injection valve (see Figure B-5).
= Plumbing the 6-port valve as a bleed valve (see Figure B-6).
* Plumbing the 10-port valve as a bleed valve (see Figure B-7).

For information about plumbing the valve for other functions, refer to the
appropriate Thermo Scientific Dionex Application Note.

To Column

AS-DV Sample Out

From Pump

Sample Loop

To Waste

Figure B-5. 6-Port Valve Plumbing for Injection Valve

»

To InjeEtion Valve
Sample In Port

AS-DV Sample Out

To Waste

Figure B-6. 6-Port Valve Plumbing for Bleed Valve
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A

To Injection Valve
Sample In Port

AS-DV Sample Out
8

To Waste

Figure B-7. 10-Port Valve Plumbing for Bleed Valve

Connect the waste line:

a.

Remove the 2-meter (78-inch) length of 0.76-mm (0.030-in) 1D
green PEEK waste line (P/N 044777), the three double-cone
ferrules, and the three 10-32 fitting bolts from the Dionex AS-DV
Valve Kit.

Install a fitting and ferrule onto the end of the waste line. See
Section 5.1 for installation and tightening requirements.

Connect the waste line to the appropriate port on the valve:
For a 6-port injection valve, connect the waste line to port 2.
For a 6-port bleed valve, connect the waste line to port 6.
For a 10-port bleed valve, connect the waste line to port 8.

Route the other end of the waste line to a waste container. Make
sure that the outlet of the waste line is below the level of the
Dionex AS-DV and is not elevated at any point.

Connect the Dionex AS-DV sample out line:

a.

Install a fitting and ferrule onto the end of the Dionex AS-DV
sample out line.

Connect the sample out line to the appropriate port on the valve:
For a 6-port injection valve, connect the sample out line to port 3.
For a 6-port bleed valve, connect the sample out line to port 5.
For a 10-port bleed valve, connect the sample out line to port 7.

Complete the plumbing for bleed valve operation:
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a. Install a fitting and ferrule onto one end of the line that will
connect the Dionex AS-DV valve to the injection valve. If you
are creating this line, use tubing appropriate for your IC system.

b. Connect the line to the appropriate port on the Dionex AS-DV
valve:
For a 6-port valve, connect the line to port 4.
For a 10-port valve, connect the line to port 6.

c. Connect the other end of the line to the sample inlet port on the
injection valve in the IC system. Use a fitting and ferrule
appropriate for your IC system.

4. To complete the 6-port valve plumbing for injection valve operation,
refer to Figure B-5 and to the manual for the IC system.

5. Replace the front cover and close the top cover on the Dionex AS-
DV.

Go on to Section B.4.

B.4 Connecting the Drain Line

1. Locate the corrugated drain hose (P/N 055075) in the Dionex AS-DV Ship
Kit.

2. Push the hose onto the DRAIN port on the
Dionex AS-DV rear panel. Make sure the
hose is pushed securely onto the port.

3. Place the free end of the hose into a waste
container or appropriate drain.

4. Make sure that the outlet of the drain line
is below the level of the Dionex AS-DV
and is not elevated at any point.
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B.5 Installing Chromeleon and the Chromeleon Software
License

Before proceeding, verify that Chromeleon is installed on the PC and the
Chromeleon software license is installed. For instructions, refer to Installing the
Chromeleon Chromatography Management System with a Dionex lon
Chromatograph (IC) (Document No. 031883). The manual is shipped with
Chromeleon.

B.6 Connecting the Dionex AS-DV to the Chromeleon PC

Do not turn on the power to the Dionex AS-DV until after you connect

IMPORTANT the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed
on the PC. If not, Windows will be unable to identify the new USB
device when the power is turned on.

1. Locate the USB cable (P/N 960777) in the Dionex AS-DV Ship Kit.

2. Connect the USB cable (P/N 960777) between the USB connector on the
Dionex AS-DV rear panel and either a USB port on the Chromeleon computer
or a USB port on the host IC system.

A USB 2.0 external hub can be used to connect the Dionex AS-DV to the PC.
Refer to the manual provided by the hub vendor for complete installation
instructions. One or more hubs is required in the following situations:

e Use a hub if the number of USB devices in the system exceeds the number of
available USB ports.

e Use a hub if the Dionex AS-DV is more than 5 meters (16 ft) from the PC.
The USB standard limits the USB cable length to 5 meters (16 ft). Each
IMPORTANT|] USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters

(32 yds) from the PC.
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B.7 Connecting the Power Cord

1. Verify that the power switch on the rear panel of the Dionex AS-DV is turned
off. (The power switch may be turned on accidentally when the module is
unpacked.)

2. Connect the power cord (IEC 320 C13) (ordered separately) from the main
power receptacle on the rear panel to a grounded power source. The Dionex
AS-DV power supply is auto-sensing, so no adjustment is required to select
the line voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the Dionex AS-DV or connect it to AC
power mains without an earthed ground connection.

P>

WARNING

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the Dionex AS-DV and is easily
accessible.

P>

CAUTION

Operation at AC input levels outside of the specified operating voltage
range may damage the Dionex AS-DV.

P>

CAUTION

DANGER D'ELECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne I'utilisez pas et ne

le branchez pas au secteur C.A. sans utiliser de branchement mis ala
MISE EN GARDE terre.

>

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez & ce que la prise de base soit
situéelinstallée preés du module et facilement accessible.

>

MISE EN GARDE

STROMSCHLAGGEFAHR—Zur  Vermeidung von elektrischen
Schlagen ist eine geerdete Steckdose zu verwenden. Das Gerat darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
WARNUNG werden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daf3 sich die Steckdose nahe am Gerét befindet und
leicht zugénglich ist.

4

VORSICHT
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B.8 Setting Up Chromeleon

This section provides brief instructions for setting up Chromeleon. For details
about any of these steps, refer to the Chromeleon Help and to Installing the
Chromeleon Chromatography Management System with a Dionex lon
Chromatograph (IC) (Document No. 031883).

B.8.1 Installing the Dionex AS-DV Device Driver

1.
2.

If you have not already done so, turn on the PC power.

For a local PC: Log onto Windows XP or Windows Vista as an
administrator.

For a network PC: Log on as a user with local PC administrator

privileges.

If Chromeleon 7 is installed, check the Instrument Controller Service

icon on the Windows taskbar and start the service, if it is not already

running:

e If theicon is gray @ | the Instrument Controller Service is
running (idle).

= If the icon is crossed out in red A , the Instrument Controller
Service is not running. Right-click the icon and click Start

Chromeleon Instrument Controller. The icon changes to gold
¢ toindicate that the Instrument Controller Service is starting.

If Chromeleon 6.8 is installed, check the Server Monitor icon on the
Windows taskbar and start the server, if it is not already running:

e Iftheiconis gray &, the server is already running (idle).

e Iftheicon is crossed out in red 4, the server is stopped. To start
the server, right-click the icon and select Start Server. The icon
changes to gold £ to indicate that the Chromeleon 6.8 Server is
starting.

Press the power switch on the Dionex AS-DV rear panel to turn on
the power.

Windows automatically detects the new USB devices. A message
flashes on the screen to inform you that new hardware was found.
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7. The Found New Hardware Wizard appears. This wizard installs the
new hardware into the Windows Device Manager.

8. Complete the wizard by selecting the following options:

* If asked whether Windows can connect to Windows Update to
search for software, select No, not this time.

e Accept the default option (Install the software automatically)
and click Next >. It is not necessary to insert a hardware
installation disk.

B.8.2 Configuring the Dionex AS-DV in Chromeleon

1. Start the Chromeleon 7 Instrument Configuration Manager or the
Chromeleon 6.8 Server Configuration program:

e For Chromeleon 7, click Start on the Windows taskbar and click
All Programs > Chromeleon 7 > Instrument Configuration
Manager.

e For Chromeleon 6.8, click Start on the Windows taskbar and
click All Programs > Chromeleon > Server Configuration.

2. Add the Dionex AS-DV to an existing instrument or timebase or
create a new instrument or timebase.
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3.

In the Dionex AS-DV Properties dialog box, click the Options tab
(see Figure B-8).

Dionex AS-DV Autosampler

General] State Devices] TTL Inputz  Dptions IE[ID[ Levels

Walve
W [I7]=T57 Label: |.~’-‘-.u:<\a"alve
o Ausiliary
" None
Drefault Injection Parameters
Drelay Walurme: 126yl
. 10—
Flush Factor: =

Total wolume delivered = [Injection Yolume + Delay Yolume] * Flush Factor

Rinze Wial Range

Start Position: 15 ﬂ
Wam !
End Position; =i

[ Sample Dverlap

Figure B-8. Dionex AS-DV Properties Dialog Box: Options Tab Page

If a high-pressure valve is installed, select the function for which the
valve will be used:

* To use the valve as an injection valve, click Injection.

= To use the valve for another function (for example, a bleed
valve), click Auxiliary.

Change other options as required for your system. For information
about the other options, click the Help button.

When the configuration is complete, select File > Save Installation.

Exit the program.
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B.8.3 Connecting to the ePanel Set or Panel Tabset

Connecting to the Chromeleon 7 ePanel Set

1. To start the Chromeleon 7 client, click Start > All Programs >
Chromeleon 7 > Chromeleon 7.

2. Todisplay the AS-DV ePanel, click the Instruments category bar on
the Console. Click your instrument in the Navigation Pane.
Chromeleon 7 connects to the instrument and displays the ePanel Set.
Click the AS-DV tab (see Figure B-9).

IC5-900.~ AS-DV | Audit Lueue

Qomeces (e

et " Drate Tirne Ritention Device Meszage
Operating Status Feady Time
Deliver Status Completed © 512200 103838 AM Uger AMarquardt...
el S m @ =1z:200 10:38:31 Al Initializing driver D...
Volume Remaining 5000 © 51220100 10:33:31 AM Driver Dionex IC5-..
© 51122010 103328 AM Initializing driver D..
Settings g 522010 10:38: 27 Ak I nitializing driver D...
) - = BAZ2010 10:38: 27 Ak Initializing driver d...
Deliver Speed 1.0 mifmin * © sizemn 10387 A IC5-300 - Chramel..
Deliver Volume 5000 3 @ 5712/2010  10:38:18 AM Initializing driver D...
vial Position 1 = @ 5122010 103318 AM Driver Diokex AS-.
© 5Az220m0 A038124M Initializing driver D..
Commands © 512/2m0 10:35:171 Ak Initializing driver d...
© 51202010 103811 AM A5-0Y - Chromels..

=D ==
==

Valve

[ A Pogition ] [ B Position ]

l Wellness Panel l

Figure B-9. Example Chromeleon 7 ePanel Set: Dionex AS-DV ePanel
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Connecting to Chromeleon 6.8

1. To start the Chromeleon client, click Start and select All Programs >

Chromeleon > Chromeleon.

To display the panel tabset,
select View > Default Panel
Tabset or click the Default
Panel Tabset toolbar button.

** Chromeleon

File  Wiew ‘Workspace Tools Help

Default Panel Tabset

To display the Dionex AS-
DV Control panel, click the AS-DV tab (see Figure B-10).

T — ]

ICS-1600 System with Calumn Heater- AS-DY ] Sequence Control } Status  ASDY I

AS-DY I+

AS-DV

¥ Connect

Stati

EE5.08:33 AM Position=3 ~

Operating Status | Ready | Position= 3

Deliver Status
Vial Size

E=R9:08:35 AW Sampler.DeliverSample “olume = 5000,

50840 AM Position=4
E=R9:08:41 AW Sampler.DeliverSample “olume = 5000,
Paosition= 4

Yolume Remaining “ =R005:57 AM Resetvials StartvialPosition=0,

EndVialPosition=10

Deliver Speed 1.0 mlimin E|3
Deliver Valume 5000 5
Vial Position 4 E|

L] B0 725 AM SamplerVialPosition = 4

<

G
“'Moveto Vial || | Deliver Sample
Stop Raise Heedle
A
Position A Position B ]

Wellness Panel

rReset Vial Memory-

Reset All

ResetVialRange“u =i =

Start Pos. End Pos.

Figure B-10. Example Chromeleon 6.8 Panel Tabset: Dionex AS-DV Control

Panel
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B.8.4

B.8.5

Verifying Chromeleon Communication

To verify that Chromeleon is communicating with the Dionex AS-DV:

1.

On the Dionex AS-DV ePanel (in Chromeleon 7) or Control panel (in
Chromeleon 6.8), under Settings, enter a Vial Position.

Under Commands, click Move to Vial. The carousel should move to
the entered position.

If an optional valve is installed: In Chromeleon 7, click the Inject
Position and then the Load Position button. In Chromeleon 6.8, click
the Position A and then the Position B button. You should hear the
valve actuate as it changes position.

If the carousel or valve do not respond, check the Chromeleon audit
trail for error messages. For troubleshooting information, refer to
Section 4.1 in this manual or to the Chromeleon Help.

Setting Up the Dionex AS-DV for Simultaneous Injections

The simultaneous injection feature allows delivery of sample to two
independent ion chromatography (IC) systems with one Dionex AS-DV
and a computer running Chromeleon. The Dionex AS-DV and AS40
Simultaneous Injection Kit for ICS Systems (P/N 060258) provides the
necessary parts and instructions for setting up this feature.
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The 4-pin connector (see Figure C-1) on the rear panel of the Dionex AS-DV
provides one relay output and one TTL input.

Figure C-1. Relay Output and TTL Input Connector (on Dionex AS-DV Rear Panel)

The relay output can be programmed in Chromeleon to switch any low-voltage
device. Switched current must be no more than 200 mA at 5 VDC.

When connected to a controlling device, a signal from the device to the TTL input
starts the load cycle. This allows the Dionex AS-DV to operate without
Chromeleon control.

This appendix provides the following information:

* A description of the Dionex AS-DV TTL input control function (see
Section C.1).

e Instructions for connecting the Dionex AS-DV relay output and TTL input
(see Section C.2).

e Example connections to a previous generation of Dionex ion chromatograph,
and instructions for controlling the Dionex AS-DV without Chromeleon (see

Section C.3).

= Instructions for controlling the Dionex AS-DV relay output with Chromeleon
(see Section C.4).
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C.1

TTL Input Function

TTL IN allows the load cycle to be started via a contact-closure relay output or TTL
output signal from a connected controlling device. When the input is triggered for
the first time, the Dionex AS-DV performs a full vial delivery on vial position 1.
When triggered again, the Dionex AS-DV performs a full vial delivery on vial
position 2, and so on. If no vial is detected, an error occurs. Triggering the input
again clears the error and moves the carousel to the next available vial.

C.1.1 Load Cycle Timing

To inject the sample at the correct time, it is important to know the length
of time required to complete the load cycle. The injection valve should
not be switched to the inject position until after the load cycle is complete.
Several factors (including vial size and delivery speed) determine the time
interval between the start of the load cycle and injection of the sample.

Table C-1 lists the times required to complete four types of load cycles.
Use these times to determine how long to wait after triggering TTL IN
before switching the injection valve to inject. (Each time value listed
allows a margin of error of approximately + 0.2 minutes.)

Vial Size Type Delivery InjectionPer  Time (Min)
Speed Vial (Full Per Sample
(mL/min) Vial) Load
Large (5.0 mL) Loop 4.0 1 2.7
Concentrator 1.0 1 8.8
Small (0.5 mL) Loop 1.6 1 13
Concentrator 0.4 1 3.4

Table C-1. Dionex AS-DV Load Cycle Times

C.1.2 Delivery Speed, Flush Factor, and TTL Homing Delay
Settings

If the Dionex AS-DV has never been connected to Chromeleon, the
following default settings for delivery speed, flush factor, and TTL
homing delay are used:

* Delivery speed: 4.0 mL/min
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e Flush factor: 10
e TTL homing delay: 90 sec

The TTL homing delay specifies the time delay before homing (raising)
the needle after delivery. For information about the flush factor, see
Section 3.5.2.

If the Dionex AS-DV has been connected to Chromeleon, the delivery
speed, flush factor, and TTL homing delay last entered are used.

To change one of the options, you can connect the Dionex AS-DV to
Chromeleon, change the option’s value, and then disconnect the Dionex
AS-DV from Chromeleon.

C.1.3 TTL Input Control Modes

To accommodate different controlling devices, the Dionex AS-DV TTL
input responds to four types of signals. The default control mode, normal
edge, is compatible with the output signals provided by Dionex products.

If the device connected to the Dionex AS-DV does not send a normal
edge signal, select the appropriate control mode. Refer to the
documentation provided with the controlling device and the information
below to determine the correct mode.

= Normal Edge: In normal edge Action OFf or No Effect
operation, the negative (falling) s R
edge of a signal turns on the EEAL
action. EDGE gy L1 ..
A
The function of the positive Action On

(rising) edge depends on the action: For on/off, or other actions that
have two options, the rising edge turns off the action. However, for
functions with only one option, the rising edge has no effect.

= Inverted Edge: The inverted [rErTE——
edge mode works identically to K= - ¥
the normal edge mode except .NVERTTE'[;
that the positive and negative EDGE g v ...
edges are reversed in function. Action OFf :fr No Effect
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Normal Pulse: In normal pulse
operation, the negative (falling)
edge of the TTL signal is the
active edge and the positive
(rising) edge is ignored.

TTL ¥ Vo

NORMAL
PULSE ,q v/

Action On Action Off

A pulse width of 50 ms or more is guaranteed to be detected. A pulse
width of 4 ms or less is guaranteed to be ignored. The action for pulse
widths that are greater than 4 ms and less than 50 ms is undefined.

Inverted Pulse: The inverted
pulse mode operates identically
to the normal pulse mode
except that the positive and
negative edges are reversed in
function.

Selecting the Control Mode

1.

Action On Action Off

TILV

INVERTED
PULSE g v

Start the Chromeleon 7 Instrument Configuration Manager or the
Chromeleon 6.8 Server Configuration program:

e For Chromeleon 7, click Start on the Windows taskbar and click
All Programs > Chromeleon 7 > Instrument Configuration

Manager.

e For Chromeleon 6.8, click Start on the Windows taskbar and
click All Programs > Chromeleon > Server Configuration.

Under the instrument or timebase, double-click the Dionex AS-DV

icon.

The Dionex AS-DV Properties dialog box appears.
Click the TTL Inputs tab and then press the F2 key.
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The Device Configuration dialog box appears (see Figure C-2).

Dionex AS-DY Autosampler

Device Configuration

Device Mame: IT TL_Input
Mode: lNormaI edge - 1

Cancel ]

Figure C-2. Device Configuration Dialog Box: Selecting the TTL Input Control Mode

4. Select the TTL input control mode required by the controlling device
from the Mode list.
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C.2 Connecting to the Relay Output and TTL Input

1. Locate the twisted pair of

wires (P/N 043598) and 4- Locking Screws
position connector plug

(P/N 923852) (see

Figure C-3) in the Dionex
AS-DV Ship Kit (for 0.5 mL
vials, P/N AAA-071115; for
5.0 mL vials, P/N 068887).

Position 1 Position 4

Figure C-3. 4-Position Relay TTL Connector Plug

To connect to RELAY OUT, connect an active wire (red) to position 1 and a
ground wire (black) to position 2. To connect to TTL IN, connect an active wire
(red) to position 3 and a ground wire (black) to position 4.

To attach a wire to the plug, strip the end of the wire (if it is not already),
insert the wire into the plug, and use a screwdriver to tighten the locking
SCrew.

When attaching wires to the connector plug, be careful not to allow

IMPORTANT| stray strands of wire to short to an adjoining position on the

connector.

3. Plug the connector into the 4-pin connector on the Dionex AS-DV rear panel

(see Figure C-1).

Connect the wires from the Dionex AS-DV connector plug to the appropriate
connector pins on the controlling device. Additional connector plugs are
provided with other Dionex products.

NOTE Check the polarity of each connection. Connect signal
wires to signal (+) pins and ground wires to ground (-)
pins. If you reverse the wires when connecting the relay
output, the relay will not work correctly.

If you connected TTL IN, verify that the correct input control mode is selected
(see Section C.1.3).
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C.3 Example Connections for Stand-Alone Operation

This section provides an example of connecting the Dionex AS-DV to a previous
generation of Dionex ion chromatograph. Relay Out 1 on the Thermo Scientific
Dionex 1C20 lon Chromatograph is used to control TTL IN on the Dionex AS-DV.

AS-DV IC20

RLY-1
ouT
RLY-2
ouT
TTL-1
ouT
TTL-2
ouT
TTL-1
IN
TTL-2
IN
TTL-3
IN
TTL-4
IN

RELAY
OUT TTLIN
1 2]3 4

®0 00
INf| JGND

L...OQQ....OQ...

Figure C-4. Example TTL Input Connection:
Dionex AS-DV Connected to Dionex IC20

To control the Dionex AS-DV, set up a Dionex 1C20 method that includes timed
events for triggering TTL IN on the autosampler. Figure C-5 illustrates the timed
events in an example method.
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Download
IC20
Method.

Timed |NIT

2.7
|

10.0* Download
| next method

Events
(Min) ‘

Send signal to
start AS-DV
load cycle.

Send Offset
command to
IC20.

Switch injection
valve to Inject
position.

Start data
collection.

back to Load

*These are example times. You can
adjust them to meet your
application’s requirements

‘ in Schedule.

End of run.

C.4 Controlling the Relay Output

Figure C-5. Dionex IC20 Timed Events Example

The Dionex AS-DV provides relay contacts for control of functions in external
devices. The relay output can be programmed in Chromeleon to switch any low-
voltage device. Switched current must be no more than 200 mA at 5 VDC. The
relay-contact closures are normally open. When the relay is closed, current flows
to the connected device.

Relay loads in excess of 200 mA or with included power supplies over
IMPORTANT] 5 \pC may damage the relay drivers on the CPU.
Use one of the following methods to control the relay output states: execute direct

control commands or include the commands in an instrument method or program.
Refer to the following instructions.
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Controlling the Relay Output Directly Using Chromeleon 7
1. Open the ePanel Set (see Section 3.4.1) and press the F8 key.

The Command window appears.
2. Inthe list of devices in the left pane, click Sampler_Relay.
3. Inthe right pane, click the Commands tab.

4. Click the required command (Closed or Open) (see the example in

Figure C-6).
& Pump_ECD Properties Corrnands
= 2'?':[ e Cormmand |F'aramelers |
=] _Inpul ; J -
SamplerFelay o —
A alve ¢ Open [ -

= Syztem
FrexStandard
Prevlnjection
Injection b
Mextlinjection

Figure C-6. Chromeleon 7 Command Window: Relay Control Commands

Controlling the Relay Output Directly Using Chromeleon 6.8
1. Open the panel tabset (see Section 3.4.2) and press the F8 key.

The Commands dialog box appears.

2. Expand the list of commands under Sampler and then under Sampler_Relay.
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3. Execute the required command (see the example in Figure C-6).

Commands - AS-DV

= Sarnpler
+ TTL_Input
- Sampler_Relay
@ State
i
2 Open
¥ Auphfalve
[E Mode
E OperatingStatus
B DeliverStatus
B vialSize
E DeliverSpeed
B Position

< |

Help
Turkz the device o,

Command:

Betention Time:

|

Duration:

Sampler_Relay. Clozed

l— [miir]

~|[0.01...59993.90 ]

Help

%]

Cloze

Figure C-7. Chromeleon 6.8 Commands Dialog Box:

Example Relay Control Command
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Controlling the Relay Output with an Instrument Method or Program

To add relay output control commands to a Chromeleon 7 instrument method, use
the Script Editor (see Figure C-1).

% =) = = AS-DY [Sequence] - Chromeleon Chromatoaraphy Studio - B x
Home (7]
Instrument Meth... « e | Commad | alue
L {Initial Time} Instrument Setup
6 Dverview L Pump_ECD.Pressure. UpperLimit 5000 [psi]
Pum - Pump_ECD, %A, Equate "eh
._\) [IES-%DD: 3 Pump_ECD.Pressure, LowerLimit 0 [psi]
Fump_ECD] 4 Sampler FlushFactor 10
F Gampler 5 Sampler Deliverspeed 1.0 [mlfmin]
= [a5-Dv: Sampler) 6 Purnp_ECD, Flow 0.50
: ]
i: System 7| = Sampler_Relay A |
|‘ 7" Script Editor | il @ State
gl 00000 9 P4 Closed
(10 |4 0.000 4 Open Q
11 = Ao alve Sampler, CycleTimestate, Hold, Timeout=Infinite
[ER A5 DY Test 12 =] System
= e w3 L
A5V Test2 I |13 |4 D000 i) Log
—_ 14 P4 Meszage
s 24 Protocal
m Injection List - P4 it ; :
|16 |4 0.000 9->J Del — | Duration = 20 [min]
17 | 4 0500 e d : 4
18 s | & |
m e
i,'“y Data Processing 19 |4 20.000 Stop Run
: 20 Pump_ECDLECD_1,AcqOff
""'n"' Report Designer 21 |End
utj Spectral Library
=
1 | il »
i —

Figure C-1. Chromeleon 7 Script Editor
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In Chromeleon 6.8, you can enter the commands on the Relay and State Devices
Options page in the Program Editor or Program Wizard (see Figure C-8).

Program Wizard: Relay and State Devices Options ['S_<|

A alve . Retention Time: [rwita] add

Pump_ECD_Relay_

Pump_ECD_Relay . Duration 0.00 [0.01...53993.90 ]

Pump_Injectifalve
Sampler_Relay

[ B O e B R

Tirne | Device | State | Druration |

@ State Sampler_Relay Cloged om
Q40
W Open

24 Closed

< |

Help
Inzerts the selected device into the list

< Back | Mest > | Cancel | Help

Figure C-8. Chromeleon 6.8 Program Wizard:
Example Relay Output Control Command
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Part Item Quantity
Number
Vials, Caps, and Accessories
038141 PolyVials and filter caps, 5.0 mL Pkg. of 250 (each)
038142 PolyVials and filter caps, 0.5 mL Pkg. of 250 (each)
039532 PolyVials and plain caps (no filters), 5.0 mL Pkg. of 250 (each)
042014 PolyVials and plain caps (no filters), 0.5 mL Pkg. of 250 (each)
038008 PolyVials, 5.0 mL Pkg. of 250
038010 PolyVials, 0.5 mL Pkg. of 250
038009 Caps, filter, 5.0 mL Pkg. of 250
038011 Caps, filter, 0.5 mL Pkg. of 250
039528 Caps, plain (no filters), 5.0 mL Pkg. of 250
079797 Caps, plain (no filters), 0.5 mL Pkg. of 250
068947 Tray for 5.0 mL vials 1
068948 Tray for 0.5 mL vials 1
071901 Adapters for 0.5 mL vials Pkg. of 50
037987 Tool, vial cap insertion 1
Tubing and Fittings
071575 Dionex AS-DV Sampling Tip Kit 25cm (1in)
074449 Fitting, bolt, 10-32 1
074373 Fitting, ferrule, double-cone 1
Kits
068920 6-Port High-Pressure Valve Kit 1
068921 10-Port High-Pressure Valve Kit 1
060258 Dionex AS-DV and AS40 Simultaneous Injection Kit 1
for ICS Systems
072678 Dionex AS-DV Preventive Maintenance Kit 1
Miscellaneous Items
055075 Drain hose, convoluted, 10-mm (0.4-in) ID, 1.2 m (4 ft) 1
long
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954745 Fuse, IEC 127, rated 3.15 A 1
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Numerics

10-port valve, 11

See also High-pressure valves
6-port valve, 11

See also High-pressure valves

A

Adapters for 0.5 mL vials, 10
Advanced Edit Mode, 31, 34
Alarm LED, 8
Alarms, 57

See also Error messages
Annual maintenance, 56
AS-DV

Front view, 7

Operating principles, 14

Overview, 1

Rear panel, 12

Ship Kit, 2

Software control, 1

Spare parts list, 115
Audit trail, 8, 57
Auxiliary valve, 11, 99

See also High-pressure valves

B

Backpressure, excessive, 67
Basic Edit Mode, 31, 33
BeginOverlap command, 53
Bleed

Description, 15

Performing, 39
Bleed valve, 16 — 17

Plumbing, 92 - 93

See also High-pressure valves

C

Cables
Power cord, 84
USB, 13, 95
Carousel
Description, 8
Loading, 25
Release button, 7, 9
Removing, 70
Carousel Error Counter, 20
Carousel LED, 8
Caution icon, 3-4
CE mark, 6
CETLus mark, 6
Chromeleon, 1
AS-DV device driver installation, 97
AS-DV Properties dialog box, 99
Audit trail, 8, 57
Configuring the AS-DV in, 98
Connecting the AS-DV to the PC, 95
Connecting to the software, 26, 100
Control panel, 18 — 19, 27, 100
Creating a program, 30
Creating a sequence, 36
Creating an instrument method, 30
Error messages, 57 — 58
Installing, 95
Instrument methods, 19
License, 95
Panel tabset, 18 — 19, 27, 100
Programs, 19
Sequences, 36
User interface, 18
Verifying communication with, 102
Version required, 1
Chromeleon Server Monitor, 28
Cleaning vials, 21
Commands
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Creating a program, 19
Creating an instrument method, 19
Concentrator mode, 30
Connected LED, 8
Control panel
AS-DV, 29, 101
Cycle Time, 32

D

Danger icon, 3 -4
Declaration of Conformity, 6
Deionized water requirements, 5
Delay Volume, 32
Delivery speed, 32
Delivery volume, 49
From sequence, 52
In Advanced Edit Mode, 50
In Basic Edit Mode, 49
Dimensions, 85
Drain port, 12
Drain line connection, 94

E

Edit Mode, 31
Electrical specifications
Fuses, 85
Main power, 85
EndSamplePrep command, 53
Environmental specifications
Humidity, 85
Operating temperature, 85
ePanel
AS-DV, 18
Error messages, 57 — 63
Extraneous peaks detected, 66

F

Facility requirements, 87
Filters, vial cap, 9

Fitting replacement, 69

Flow schematics
High-pressure valves, 16

Flush Factor, 32

Front interior, 11
Accessing, 11

Front view, 7

Fuses, 13
Replacing, 84
Requirements, 85

H

High-pressure valves, 11
Configuring as a bleed valve, 17, 99
Configuring as an auxiliary valve, 99
Configuring as an injection valve, 99
Configuring in Chromeleon, 99
Controlling, 33 — 34
Flow schematics, 16
Installing, 90
Operating principles, 15
Operation, 16
Plumbing, 92
Rebuilding, 79
Replacing mechanical parts (pod), 81
Humidity limits, 85

IC applications
Deionized water requirements, 5
Icons used in manual, 3
Important icon, 3
Injection valve, 11, 99
Plumbing, 92
See also High-pressure valves
Installation instructions, 87
Chromeleon connection, 95
Chromeleon setup, 97

Configuring the AS-DV in Chromeleon, 98

Drain line connection, 94
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High-pressure valve installation, 90
Power cord connection, 96
Sample out line connection, 88
Simultaneous injection setup, 102
TTL and relay connectors, 108
Unpacking the AS-DV, 87
Instrument methods (Chromeleon), 19
Creating, 30
Creating instrument methods, 19
General parameters, 32
Loading a concentrator column, 30
Loading a loop, 30
Interrupting the autosampler, 38
Inverted edge TTL input control, 105
Inverted pulse TTL input control, 106

J

Jammed autosampler, 68

L

Labels, safety, 5
Leaks, 64

LED display, 8

Load cycle timing, 104
Loop mode, 30

M

Main power receptacle, 13
Maintenance, 56
Messages

Error, 58

Safety, 3

N

Needle Error Counter, 20
Normal edge TTL input control, 105
Normal pulse TTL input control, 106

O

Operating features
Front interior, 11
Front view, 7
Rear panel, 12
Operating principles, 14
High-pressure valves, 15
Rinsing, 15
Operating temperature, 85
Optional high-pressure valves, 11
Overlap Mode, 53

P

Parameters
Chromeleon commands, 19
PGM file
See Programs (Chromeleon)
Physical specifications
Dimensions, 85
Weight, 85
Plumbing the high-pressure valve, 92
PolyVials, 1, 9
See also Vials
Poor peak reproducibility, 65
Power cord, 84, 96
Power LED, 8
Power receptacle, 13, 96
Power requirements, 85
Power switch, 13
Priority sample, 48
Programs (Chromeleon)
Creating, 19, 30
General parameters, 32
Loading a concentrator column, 30
Loading a loop, 30

R

Rear panel, 12
Fuses, 13
Power receptacle, 13
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Power switch, 13
USB receptacle, 13
Rebuilding the high-pressure valve, 79
Regulatory information, 3
Relay output, 13
Connection instructions, 108
Controlling, 110
Description, 103
Reordering information, 115
Replacing the sampling tip, 74
Replacing tubing and fittings, 69
Replacing vials during a run, 47
Returning to a vial, 47
Rinse vial positions, 45
Rinses
Operating principles, 15
Performing, 42
Running, 38
Replacing vials during, 47

S

Safety icons, 3-5
Safety messages, 3 -4
Safety symbols, 5
Sample out line, 11
Connecting, 88
Sample Overlap Mode, 53, 55
Sample vials
See Vials
Sampling head
Raising manually, 77
Sampling head tower, 8
Sampling mechanism, 8
Specifications, 86
Sampling tip, 14
Replacing, 74
Sensors, 8
Sequence Wizard (Chromeleon), 36
Sequences (Chromeleon), 36
Service procedures, 69
Fuse replacement, 84
High-pressure valve pod replacement, 81

Manually raising sampling head, 77
Sampling tip replacement, 74
Tubing and fittings replacement, 69
Ship Kit, 2
Simultaneous injections, 102
Spare parts list, 115
Specifications
Electrical, 85
Environmental, 85
Physical, 85
Sample vials, 86
Sampling mechanism, 86
Speed Adjustment Counter, 20
Stand-alone operation, 109
Starting a run, 38
Symbols, safety, 5
System Wellness, 19

T

Technical Support, 3, 56 — 57, 69
Tool
Vial cap insertion, 9
Total Volume Delivered Estimator, 31, 52
Trace-level analyses, 22
Troubleshooting
Autosampler jammed, 68
Autosampler stops, 67
Error messages, 57
Excessive backpressure, 67
Leaks, 64
Sample not loaded, 66
TTL and relay connectors
Installation instructions, 108
TTL input, 13
Connection instructions, 108
Control modes, 105
Function, 103 — 104
Tubing replacement, 69

Index-4

Doc. 065259-05 10/12



Index

U

Unexpected peaks detected, 66
Unpacking the AS-DV, 87
USB cable, 95

USB receptacle, 13

\%

Valve Actuation Counter, 20
Valves
See High-pressure valves
Vial adapters for 0.5 mL vials, 10
Vial caps, 9
Cleaning, 22
Filters, 9
Insertion tool, 9
Installing, 24
Vial Process Counter, 20
Vial sensors, 8
Vial tray, 10
Vials, 1,9
Cleaning, 21
Filling, 23
Preparing, 21
Specifications, 86

W

Warning icon, 3 -4
Warranty, voiding, 69
Weight, 85

Wellness, 19
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